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HP All-in-One overview
The HP 915 All-in-One is a versatile device that gives you easy-to-use copying, scanning,
and printing.
Copy
The HP All-in-One allows you to produce high-quality color and black-and-white copies
on a variety of paper types. You can enlarge or reduce the size of an original to fit a
specific paper size, adjust the copy quality, and make high-quality copies of photos.
Scan
Scanning is the process of converting text and pictures into an electronic format for your
computer. You can scan almost anything (photos, magazine articles, and text documents)
on the HP All-in-One.
Print from your computer
The HP All-in-One can be used with any software application that allows printing. You
can print a range of projects, such as borderless images, newsletters, greeting cards,
iron-on transfers, and posters.
This section contains the following topics:
•
•
•
•

The HP All-in-One at a glance
Control panel buttons
Status light overview
Use the HP Photosmart software
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*

Label

Description

1

Control panel

2

Input tray

3

Tray extender

4

Paper-width guide

5

Print cartridge door

6

Glass

7

Lid backing

8

Rear door

9

Rear USB port

10

Power connection*
Use only with the power adapter supplied by HP.

Control panel buttons

HP All-in-One overview
Label

Icon

1

8

Name and Description
On: Turns the HP All-in-One on or off. The On button is lit when the HP Allin-One is powered on. The light blinks while performing a job.

HP All-in-One overview

(continued)
Label

Icon

Name and Description
When the HP All-in-One is off, a minimal amount of power is still used by the
device. To completely disconnect the power supply to the HP All-in-One, turn
the device off, and then unplug the power cord.
CAUTION: Before you unplug the power cord, you must press the On
button and allow the HP All-in-One to turn itself off. This prevents the print
cartridges from drying out.

2

Cancel: Stops a print, copy, or scan job.

3

Resume: Instructs the HP All-in-One to continue after a problem is solved.
A blinking Resume light next to the Resume button indicates the need to
load paper or clear a paper jam.

4

Check Print Cartridge lights: Indicates the need to reinsert the specified print
cartridge, replace the print cartridge, or close the print cartridge door. The
Black/Photo light indicates that the problem is with the black or photo print
cartridge, and the Color light indicates that the problem is with the tri-color
print cartridge.

5

Start Copy Color: Starts a color copy job.
Press this button multiple times to specify multiple color copies. The printer
will start printing shortly after the number of copies have been selected. The
number of copies to be printed is shown to the right of this button.
TIP: The maximum number of copies you can make using the control panel
is 9. To make more copies at once, use the HP Software. When initiating
multiple copies of an original from the software, only the last digit of the
number of copies is represented on the control panel. For example, if you
are making 25 copies, the number 5 appears on the display.
Start Copy Black: Starts a black-and-white copy job.
Press this button multiple times to specify multiple black copies. The printer
will start printing shortly after the number of copies have been selected. The
number of copies to be printed is shown to the right of this button.
TIP: The maximum number of copies you can make using the control panel
is 9. To make more copies at once, use the HP Software. When initiating
multiple copies of an original from the software, only the last digit of the
number of copies is represented on the control panel. For example, if you
are making 25 copies, the number 5 appears on the display.

7

Paper Type: Changes the paper type setting to either plain or photo paper.
Make sure the appropriate paper type is loaded in the input tray. The default
paper type setting is Plain.
The Paper Type lights indicate the currently selected paper type, Plain or
Photo.

8

Photosmart Essential button: Launches the HP Photosmart Software for
printing, editing, and sharing photos.
NOTE: If the HP Photosmart Software is not installed on your computer,
the Photosmart Essential button will not do anything.

Control panel buttons
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(continued)
Label

Icon

Name and Description

9

Scan: Starts scanning the original currently on the glass. The Scan command
is ignored if the HP All-in-One is busy with any other job. The Scan command
functions only when the computer is on.

Status light overview
Several indicator lights inform you of the status of the HP All-in-One.

Label

Description

1

On button

2

Resume light

3

Check Print Cartridge lights

4

Paper Type lights (for the Paper Type button)

The following table describes common situations and explains what the lights mean.

HP All-in-One overview

Light status

What it means

All lights are off.

The HP All-in-One is turned off. Press the On button to turn on the device.

The On light and one of the Paper
Type lights are on.

The HP All-in-One is ready for printing, scanning, or copying.

The On light is blinking.

The HP All-in-One is busy printing, scanning, copying, or aligning the
print cartridges.

The On light blinks quickly for 3
seconds and then is on steady.

You pressed a button while the HP All-in-One is already busy printing,
scanning, copying, or aligning the print cartridges.

The On light blinks for 20 seconds
and then is steady.

You pressed the Scan button and there was no response from the
computer.

The Resume light is blinking.

•
•
•

The HP All-in-One is out of paper.

•
•
•

The print cartridge door is open.

The Check Print Cartridge light is
blinking.
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The HP All-in-One has a paper jam.
The paper size setting in the copy software does not match the paper
size detected in the input tray.
The print cartridges are missing or not seated correctly.
The tape was not removed from the print cartridge.

(continued)
Light status

What it means

•
•

The print cartridge is not intended for use in this HP All-in-One.
The print cartridge might be defective.

The On, Resume, and Check Print
Cartridge lights are blinking.

Scanner failure.

All lights are blinking.

The HP All-in-One has a fatal error.

Turn off the HP All-in-One, then turn it on again. If the problem persists,
contact HP Support.

1.
2.
3.
4.

Turn the HP All-in-One off.
Unplug the power cord.
Wait a minute, then plug the power cord back in.
Turn the HP All-in-One back on.

If the problem persists, contact HP Support.

Use the HP Photosmart software
The HP Photosmart Software provides a fast and easy way to make prints of your photos.
It also provides access to other basic HP imaging software features, such as saving and
viewing your photos.
For more information on using the HP Photosmart Software:

•

Check the Contents panel on the left. Look for the HP Photosmart Software Help
contents book at the top.
If you do not see the HP Photosmart Software Help contents book at the top of the
Contents panel, access the software help through the HP Solution Center.

HP All-in-One overview

•

Use the HP Photosmart software
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Find more information
You can access a variety of resources, both printed and onscreen, that provide
information about setting up and using the HP All-in-One.
Setup Guide
The Setup Guide provides instructions for setting up the HP All-in-One and
installing software. Make sure you follow the steps in the Setup Guide in order.
If you have problems during setup, check the Setup Guide for troubleshooting
information, or see Troubleshooting in this onscreen Help.

Basics Guide
HP Photosmart
2600 series printer
User Guide

The Basics Guide contains an overview of the HP All-in-One, including stepby-step instructions for basic tasks, troubleshooting tips, and technical
information.

HP Photosmart Essential animations
The HP Photosmart Essential animations are an interactive way to get a brief
overview of the software included with the HP All-in-One. You will learn how the
software can help you create, share, organize, and print your photos.
Onscreen Help
The onscreen Help provides detailed instructions on using all features of the
HP All-in-One.

•
•
•

The How Do I? topic provides links so you can quickly find information on
performing common tasks.
The The HP All-in-One overview topic provides general information about
the main features of the HP All-in-One.
The Troubleshooting topic provides information about resolving errors
you might encounter with the HP All-in-One.

Readme
The Readme file contains the most recent information which might not be found
in other publications.
Install the software to access the Readme file.
If you have Internet access, you can get help and support from the HP Web
site. This Web site offers technical support, drivers, supplies, and ordering
information.
Find more information

www.hp.com/support

Find more information
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How do I?
This section contains links to commonly performed tasks, such as printing photos and
optimizing your print jobs.
•
•
•
•
•
•
•
•
•

How do I change the print settings?
How do I print borderless photos on 10 x 15 cm (4 x 6 inch) paper?
How do I load envelopes?
How do I scan using the control panel?
How do I get the best print quality?
How do I print on both sides of the paper?
How do I replace the print cartridges?
How do I align the print cartridges?
How do I clear a paper jam?

How do I?
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Connection information
The HP All-in-One comes equipped with a USB port so you can connect directly to a
computer using a USB cable. You can also share the device over an existing home
network.
This section contains the following topics:
•
•

Supported connection types
Use printer sharing

Supported connection types
Description

Recommended number
of connected
computers for best
performance

Supported software
features

Setup instructions

USB connection

One computer connected
with a USB cable to the
rear USB 1.1 full speed
peripheral connection
port on the HP All-in-One.

All features are
supported.

Follow the Setup Guide
for detailed instructions.

Printer sharing

Five.

All features resident on
the host computer are
supported. Only printing
is supported from the
other computers.

Follow the instructions in
Use printer sharing.

The host computer must
be on at all times in order
to print from the other
computers.

Use printer sharing
If your computer is on a network, and another computer on the network has an HP Allin-One connected to it by a USB cable, you can print to that printer using printer sharing.
The computer directly connected to the HP All-in-One acts as the host for the printer and
has full software functionality. The other computer, which is referred to as a client, has
access only to the print features. You must perform other functions from the host
computer or from the control panel on the HP All-in-One.
To enable printer sharing on a Windows computer
▲ Refer to the user guide that came with your computer or see the Windows onscreen
Help.

Connection information
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The following table contains a list of supported connection types.
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Load originals and load paper
You can load many different types and sizes of paper in the HP All-in-One, including letter
or A4 paper, photo paper, transparencies, and envelopes.
This section contains the following topics:
•
•
•
•

Load originals
Choose papers for printing and copying
Load paper
Avoid paper jams

Load originals
You can copy or scan up to letter- or A4-size originals by loading them on the glass.

To load an original on the glass
1. Lift the lid on the HP All-in-One.
2. Place your original with the side you want to copy or scan face down on the left front
corner of the glass.
TIP: For more help on loading an original, refer to the engraved guides along the
edge of the glass.

Load originals and load paper

TIP: To get the correct copy size, make sure that there is no tape or other foreign
object on the glass.

3. Close the lid.

Choose papers for printing and copying
You can use different types and sizes of paper in the HP All-in-One. Review the following
recommendations to get the best printing and copying quality. Whenever you change
paper types, remember to change the paper type settings. For more information, see Set
the paper type for printing.
Load originals and load paper
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This section contains the following topics:
•
•
•

Recommended papers for printing and copying
Recommended papers for printing only
Papers to avoid

Recommended papers for printing and copying
If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing. If you are printing photos, for example,
load HP Premium or HP Premium Plus photo paper in the input tray.
The following is a list of HP papers you can use for copying and printing. Depending on
your country/region, some of these papers might not be available.
NOTE: This device supports 10 x 15 cm (4 x 6 inch) with tab, A4-, letter-, and legal(US only) size paper only.
NOTE: To achieve a borderless print, you must use 10 x 15 cm (4 x 6 inch) paper
with tab. The HP All-in-One prints to the edge of three sides of the paper. When you
remove the tab from the fourth side, you have a borderless print.
HP Premium Plus Photo Paper
HP Premium Plus Photo Papers are the best HP photo paper, with image quality and
fade resistance superior to store-processed photos. They are ideal for printing your highresolution images for framing or including in a photo album. These papers are available
in several sizes, including 10 x 15 cm (4 x 6 inch) (with or without tabs), A4, and 8.5 x 11
inch sizes for printing or copying photos from the HP All-in-One.
Load originals and load paper

HP Premium Photo Paper
HP Premium Photo Papers are high-quality, glossy-finish or soft gloss-finish photo
papers. They look and feel like store-processed photos and can be mounted under glass
or in an album. These papers are available in several sizes, including 10 x 15 cm (4 x 6
inch) (with or without tabs), A4, and 8.5 x 11 inch sizes for printing or copying photos from
the HP All-in-One.
HP Premium Inkjet Transparency Film and HP Premium Plus Inkjet Transparency
Film
HP Premium Inkjet Transparency Film and HP Premium Plus Inkjet Transparency Film
make your color presentations vivid and even more impressive. This film is easy to use
and handle and dries quickly without smudging.
HP Premium Inkjet Paper
HP Premium Inkjet Paper is the ultimate coated paper for high-resolution usage. A
smooth, matte finish makes it ideal for your highest-quality documents.
HP Bright White Inkjet Paper
HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque
enough for two-sided color usage with no show-through, which makes it ideal for
newsletters, reports, and flyers.
20
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HP All-in-One Paper or HP Printing Paper
Ensure that the Plain paper type is selected when using HP All-in-One Paper and
HP Printing Paper.
•

•

HP All-in-One Paper is specifically designed for HP All-in-One devices. It has an extra
bright blue-white shade that produces sharper text and richer colors than ordinary
multifunction papers.
HP Printing Paper is a high-quality multifunction paper. It produces documents that
look and feel more substantial than documents printed on standard multipurpose or
copy paper.

To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted,
choose your country/region, follow the prompts to select your product, and then click one
of the shopping links on the page.
NOTE: At this time, some portions of the HP Web site are available in English only.

Recommended papers for printing only
Certain papers are supported only when you start the print job from your computer. The
following list provides information about these papers.
If you want the best print quality, HP recommends using HP papers. Using paper that is
too thin or too thick, paper that has a slick texture, or paper that stretches easily can cause
paper jams. Using paper that has a heavy texture or does not accept ink can cause printed
images to smear, bleed, or not fill in completely.

HP Iron-On Transfers
HP Iron-On Transfers (for color fabrics or for light or white fabrics) are the ideal solution
for creating custom T-shirts from your digital photos.
HP Inkjet labels
Letter or A4 label sheets designed for use with HP inkjet products (like HP inkjet labels).
HP Brochure & Flyer Paper
HP Brochure & Flyer Paper (Gloss or Matte) is glossy-coated or matte-coated on both
sides for two-sided use. They are the perfect choice for near-photographic reproductions
and business graphics for report covers, special presentations, brochures, mailers, and
calendars.
HP Premium Presentation Paper
HP Premium Presentation Paper gives your presentation a quality look and feel.
HP CD/DVD Tattoos
HP CD/DVD Tattoos allow you to personalize your CDs and DVDs by printing highquality, low-cost CD or DVD labels.
To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted,
choose your country/region, follow the prompts to select your product, and then click one
of the shopping links on the page.
Choose papers for printing and copying
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Depending on your country/region, some of these papers might not be available.

Chapter 6

NOTE: At this time, some portions of the HP Web site are available in English only.

Papers to avoid
Using paper that is too thin or too thick, paper that has a slick texture, or paper that
stretches easily can cause paper jams. Using paper that has a heavy texture or does not
accept ink can cause printed images to smear, bleed, or not fill in completely.
NOTE: For a complete list of supported media sizes, see the printer software.
Papers to avoid for all print and copy jobs
• Any size paper other than those listed in the technical specifications chapter of your
printed documentation.
• Paper with cutouts or perforations (unless specifically designed for use with HP inkjet
devices).
• Highly textured stock, such as linen. It might not print evenly, and the ink can bleed
into these papers.
• Extremely smooth, shiny, or coated papers not specifically designed for the HP Allin-One. They can jam the HP All-in-One or repel the ink.
• Multi-part forms, such as duplicate and triplicate forms. They can wrinkle or get stuck,
and the ink is more likely to smear.
• Envelopes with clasps or windows. They can get stuck in the rollers and cause paper
jams.
• Banner paper.

Load originals and load paper

Additional papers to avoid when copying
• Envelopes.
• Transparency film other than HP Premium Inkjet Transparency Film or HP Premium
Plus Inkjet Transparency Film.
• Iron-On Transfers.
• Greeting card paper.

Load paper
This section describes the procedure for loading different types and sizes of paper into
the HP All-in-One for your copies or printouts.
NOTE: After a copy or print job has started, the paper width sensor can determine
whether the paper is Letter, A4, or a smaller size.
TIP: To help prevent rips, wrinkles, and curled or bent edges, store all paper flat in
a resealable bag. If the paper is not stored properly, extreme changes in temperature
and humidity might result in curled paper that does not work well in the HP All-in-One.
This section contains the following topics:
•
•

22

Load full-size paper
Load 10 x 15 cm (4 x 6 inch) photo paper

Load originals and load paper

•
•
•

Load index cards
Load envelopes
Load other types of paper

Load full-size paper
You can load many types of letter or A4 paper into the input tray of the HP All-in-One.

To load full-size paper
1. Flip the tray extender up toward you.

NOTE: When you use legal-size paper, leave the tray extender closed.

3. Tap a stack of paper on a flat surface to align the edges, and then check the paper
for the following:
• Make sure it is free of rips, dust, wrinkles, and curled or bent edges.
• Make sure all the paper in the stack are the same size and type.

Load paper
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2. Slide the paper-width guide to its outermost position.

Chapter 6

4. Insert the stack of paper into the input tray with the short edge forward. Ensure that
the side you want to print on faces down. Slide the stack of paper toward the device
until it stops.

CAUTION: Make sure that the HP All-in-One is idle and silent when you load
paper into the input tray. If the HP All-in-One is servicing the print cartridges or
otherwise engaged in a task, the paper stop inside the device might not be in
place. You could push the paper too far forward, causing the HP All-in-One to
eject blank pages.
TIP: If you are using letterhead, insert the top of the page first with the side you
want to print on facing down. For more help on loading full-size paper and
letterhead, refer to the diagram engraved in the base of the input tray.
5. Slide the paper-width guide inward until it stops at the edge of the paper.
Do not overload the input tray; make sure the stack of paper fits within the input tray
and is no higher than the top of the paper-width guide.
Load originals and load paper

Load 10 x 15 cm (4 x 6 inch) photo paper
You can load 10 x 15 cm (4 x 6 inch) photo paper into the input tray of the HP All-in-One.
For the best results, use 10 x 15 cm (4 x 6 inch) HP Premium Plus Photo Paper or HP
Premium Photo Paper with tab.
NOTE: For borderless printing, the HP All-in-One only supports 10 x 15 cm (4 x 6
inch) photo paper with a tear-off tab. You can automatically adjust the settings in the
Properties dialog box to print a borderless 10 x 15 cm (4 x 6 inch) photo on
HP Premium Plus Photo Paper. Click the Printing Shortcuts tab, and then, in the
Printing Shortcuts list, select Photo printing-borderless.
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TIP: To help prevent rips, wrinkles, and curled or bent edges, store all paper flat in
a resealable bag. If the paper is not stored properly, extreme changes in temperature
and humidity might result in curled paper that does not work well in the HP All-in-One.

To load 10 x 15 cm ( 4 x 6 inch) photo paper with tab in the input tray
1. Remove all paper from the input tray.
2. Insert the stack of photo paper into the far-right side of the input tray with the short
edge forward. Ensure that the side you want to print on faces down. Slide the stack
of photo paper toward the device until it stops.
Load the photo paper so that the tabs are closest to you.
TIP: For more help on loading small-size photo paper, refer to the guides
engraved in the base of the input tray for loading photo paper.

For best results, set the paper type before copying or printing.
Related topics
• Recommended papers for printing and copying
• Change the print settings for the current job
• Set the copy paper type

Load index cards
You can load index cards into the input tray of the HP All-in-One to print notes, recipes,
and other text.
For best results, set the paper type before copying or printing.
NOTE: The HP All-in-One leaves a 1.2 cm (.5 inch) border on one short edge. Before
printing many cards, print one test card to make sure that the border does not crop
your text.

Load paper
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3. Slide the paper-width guide inward until it stops at the edge of the paper.
Do not overload the input tray; make sure the stack of paper fits within the input tray
and is no higher than the top of the paper-width guide.
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To load index cards in the input tray
1. Remove all paper from the input tray.
2. Insert the stack of cards, with the side you want to print on facing down, into the farright side of the input tray. Slide the stack of cards forward until it stops.
3. Slide the paper-width guide inward against the stack of cards until it stops.
Do not overload the input tray; make sure the stack of cards fits within the input tray
and is no higher than the top of the paper-width guide.

For best results, set the paper type before copying or printing.
Related topics
• Load 10 x 15 cm (4 x 6 inch) photo paper
• Change the print settings for the current job
• Set the copy paper type

Load envelopes
You can load one or more envelopes into the input tray of the HP All-in-One. Do not use
shiny or embossed envelopes or envelopes that have clasps or windows.
Load originals and load paper

NOTE: For specific details on how to format text for printing on envelopes, consult
the help files in your word processing software. For best results, consider using a label
for the return address on envelopes.

26

Load originals and load paper

To load envelopes
1. Remove all paper from the input tray.
2. Insert one or more envelopes into the far-right side of the input tray with the envelope
flaps up and on the left. Slide the stack of envelopes forward until it stops.
TIP: For more help on loading envelopes, refer to the diagram engraved in the
base of the input tray.
3. Slide the paper-width guide inward against the stack of envelopes until it stops.
Do not overload the input tray; make sure the stack of envelopes fits within the input
tray and is not higher than the top of the paper-width guide.

Load other types of paper
NOTE: Not all paper sizes and paper types are available with all the functions on
the HP All-in-One. Some paper sizes and paper types can only be used if you are
starting a print job from the Print dialog box in a software application. They are not
available for copying. Papers that are only available for printing from a software
application are indicated as such.
HP Premium Inkjet Transparency Film and HP Premium Plus Inkjet Transparency
Film
▲ Insert the film so that the white transparency strip (with arrows and the HP logo) is on
top and is going into the input tray first.
NOTE: The HP All-in-One cannot automatically detect the paper type. For best
results, set the paper type to transparency film in the software before printing onto
transparency film.
HP Iron-On Transfers (for printing only)
1. Flatten the transfer sheet completely before using it; do not load curled sheets.
TIP: To prevent curling, keep transfer sheets sealed in the original package until
you are ready to use them.
2. Locate the blue stripe on the nonprinting side of the transfer paper and then manually
feed one sheet at a time into the input tray with the blue stripe facing up.

Load paper
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The following papers require extra attention to load them properly.
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HP Inkjet labels (for printing only)
1. Always use letter or A4 label sheets designed for use with HP inkjet devices (such as
HP inkjet labels), and make sure that the labels are no more than two years old. Labels
on older sheets might peel off when the paper is pulled through the HP All-in-One,
causing subsequent paper jams.
2. Fan the stack of labels to make sure none of the pages are sticking together.
3. Place a stack of label sheets on top of full-size plain paper in the input tray, label side
down. Do not insert labels one sheet at a time.
For best results, set the paper type before copying or printing.
HP CD/DVD Tattoo labels (for printing only)
▲ Place one sheet of CD/DVD tattoo paper in the input tray with the print side down;
slide the CD/DVD tattoo paper forward until it stops.
NOTE: When you use CD/DVD tatoo labels, leave the tray extender closed.
Related topics
• Load 10 x 15 cm (4 x 6 inch) photo paper
• Set the paper type for printing
• Set the copy paper type

Avoid paper jams
To help avoid paper jams, follow these guidelines.

Load originals and load paper

•
•
•
•
•
•
•

Remove printed papers from the output tray frequently.
Prevent curled or wrinkled paper by storing all unused paper flat in a resealable bag.
Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.
Do not combine different paper types and paper sizes in the input tray; the entire stack
of paper in the input tray must be the same size and type.
Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure
the paper-width guide does not bend the paper in the input tray.
Do not force paper too far forward in the input tray.
Use paper types that are recommended for the HP All-in-One.

Related topics
Papers to avoid
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The HP All-in-One can be used with any software application that allows printing. You
can print a range of projects, such as borderless images, newsletters, greeting cards,
iron-on transfers, and posters.
This section contains the following topics:
•
•
•
•
•
•
•
•

Print from a software application
Make the HP All-in-One the default printer
Change the print settings for the current job
Change the default print settings
Printing shortcuts
Perform special print jobs
Stop a print job
Resume a print job

Print from a software application
Most print settings are automatically handled by the software application. You need to
change the settings manually only when you change print quality, print on specific types
of paper or transparency film, or use special features.
To print from a software application
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Select the HP All-in-One as the printer.
If you set the HP All-in-One as the default printer, you can skip this step. The HP Allin-One will already be selected.
4. If you need to change settings, click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
NOTE: When printing a photo, you must select options for the correct paper type
and photo enhancement.
5. Select the appropriate options for your print job by using the features available in the
Advanced, Printing Shortcuts, Features, and Color tabs.

Print

TIP: You can easily select the appropriate options for your print job by choosing
one of the predefined print tasks on the Printing Shortcuts tab. Click a type of
print task in the Printing Shortcuts list. The default settings for that type of print
task are set and summarized on the Printing Shortcuts tab. If necessary, you
can adjust the settings here and save your custom settings as a new printing
shortcut. To save a custom printing shortcut, select the shortcut and click Save
As. To delete a shortcut, select the shortcut and click Delete.

Print from your computer
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6. Click OK to close the Properties dialog box.
7. Click Print or OK to begin printing.

Make the HP All-in-One the default printer
You can set the HP All-in-One as the default printer to use from all software applications.
This means that the HP All-in-One is automatically selected in the printer list when you
select Print from the File menu in a software application. The default printer is also printed
to automatically when you click the Print button in the toolbar of most software
applications. For more information, see the Windows Help.

Change the print settings for the current job
You can customize the print settings of the HP All-in-One to handle nearly any print task.
This section contains the following topics:
•
•
•
•
•
•
•
•

Set the paper size
Set the paper type for printing
View the print resolution
Change the print speed or quality
Change the page orientation
Scale the document size
Change the saturation, brightness, or color tone
Preview your print job

Set the paper size
The paper size setting helps the HP All-in-One determine the printable area on the page.
Some of the paper size choices have a borderless equivalent, which allows you to print
to the top, bottom, and side edges of the paper.
Usually, you set the paper size in the software application you used to create your
document or project. However, if you are using custom-size paper, or if you cannot set
the paper size from your software application, you can change the paper size in the
Properties dialog box before printing.
To set the paper size
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Resizing Options area, click the appropriate paper size from the Size list.
The following table lists the suggested paper size settings for the different types of
paper you can load in the input tray. Make sure to look at the long list of choices in
Print
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the Size list to see if a defined paper size already exists for the type of paper you are
using.
Paper type

Suggested paper size settings

CD/DVD tattoo paper

5 x 7 in.

Copier, multi-purpose, or
plain papers

Letter or A4

Envelopes

Appropriate listed envelope size

Greeting-card papers

Letter or A4

Index cards

Appropriate listed card size (if listed sizes are not appropriate,
you can specify a custom paper size)

Inkjet papers

Letter or A4

Iron-on T-shirt transfers

Letter or A4

Labels

Letter or A4

Legal

Legal

Letterhead

Letter or A4

Panorama photo paper

Appropriate listed panorama size (if listed sizes are not
appropriate, you can specify a custom paper size)

Photo papers

10 x 15 cm. (with or without tab), 4 x 6 in. (with or without tab),
letter, A4, or appropriate listed size

Transparency films

Letter or A4

Custom-size papers

Custom paper size

Set the paper type for printing
If you print on special papers, such as photo paper, transparency film, envelopes, or
labels, or if you experience poor print quality, you can set the paper type manually.
To set the paper type for printing
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Basic Options area, click the appropriate paper type from the Paper Type list.

View the print resolution

Print

The printer software displays the print resolution in dots per inch (dpi). The dpi varies
according to the paper type and print quality that you select in the printer software.

Change the print settings for the current job
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To view the print resolution
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Print Quality drop-down list, select the appropriate print quality setting for your
project.
7. In the Paper Type drop-down list, select the type of paper that you have loaded.
8. Click the Resolution button to view the print resolution dpi.

Change the print speed or quality
The HP All-in-One automatically chooses a print quality and speed setting depending on
the paper type setting you select. You can also change the print quality setting to
customize the speed and quality of the print process.
To select a print speed or quality
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Print Quality drop-down list, select the appropriate quality setting for your
project.
NOTE: To view the maximum dpi that the HP All-in-One will print, click
Resolution.
7. In the Paper Type drop-down list, select the type of paper that you have loaded.

Change the page orientation
The page orientation setting allows you to print your document vertically or horizontally
on the page.
Usually, you set the page orientation in the software application you used to create your
document or project. However, if you are using custom-size or special HP paper, or if you
cannot set the page orientation from your software application, you can change the page
orientation in the Properties dialog box before printing.
To change the page orientation
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
Print
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3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Basic Options area, click one of the following:
• Click Portrait to print the document vertically on the page.
• Click Landscape to print the document horizontally on the page.

Scale the document size
The HP All-in-One allows you to print the document at a different size than the original.
To scale the document size
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Resizing options area, click Scale to paper size, and then click the
appropriate paper size from the drop-down list.

Change the saturation, brightness, or color tone
You can change the intensity of colors and the level of darkness in your printout by
adjusting the Saturation, Brightness, and Color Tone options.
To change the saturation, brightness, or color tone
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Color tab.
6. Click the More color options button.
7. Move the sliders to adjust the Saturation, Brightness, or Color Tone.
• Brightness indicates the lightness or darkness of the printed document.
• Saturation is the relative purity of printed colors.
• Color tone affects the perceived warmth or coolness of printed colors, by adding
more orange or blue tones, respectively, to your image.

You can preview your print job before sending it to the HP All-in-One. This helps to prevent
wasting paper and ink on projects that do not print as expected.
Change the print settings for the current job
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To preview your print job
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Select the print settings appropriate for your project on each of the tabs in the dialog
box.
6. Click the Features tab.
7. Select the Show Preview Before Printing check box.
8. Click OK, and then click Print or OK in the Print dialog box.
Your print job displays in the preview window.
9. In the HP preview window, do one of the following:
• To print, click Start Printing.
• To cancel, click Cancel Printing.

Change the default print settings
If there are settings that you frequently use for printing, you might want to make them the
default print settings so they are already set when you open the Print dialog box from
within your software application.
To change the default print settings
1. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Settings.
2. Make changes to the print settings, and click OK.

Printing shortcuts
Use printing shortcuts to print with print settings that you use often. The printer software
has several specially designed printing shortcuts that are available in the Printing
Shortcuts list.
NOTE: When you select a printing shortcut the appropriate printing options are
automatically displayed. You can leave them as is or change them. You can also
create a shortcut. For more information, see Create printing shortcuts.
Use the Printing Shortcuts tab for the following print tasks:
•
•

•
•

General Everyday Printing: Print documents quickly.
Photo Printing–Borderless: Print to the top, bottom, and side edges of 10 x 15 cm
(4 x 6 inch) HP Premium Plus Photo Papers with a tear-off tab. For more information,
see Print a borderless image.
Photo Printing–With White Borders: Print a photo with a white border around the
edges. For more information, see Print a photo on photo paper.
Fast/Economical printing: Produce draft-quality printouts quickly.
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•

•

Presentation printing: Print high-quality documents, including letters and
transparencies. For more information, see Print from a software application and Print
on transparencies.
Two-sided (Duplex) Printing: Print two-sided pages with the HP All-in-One
manually. For more information, see Print on both sides of the page.

Create printing shortcuts
In addition to the printing shortcuts that are available in the Printing Shortcuts list, you
can create your own printing shortcuts.
If you frequently print on transparency film, for example, you can create a printing shortcut
by selecting the Presentation Printing shortcut, changing the paper type to HP Premium
Inkjet Transparency Film, and then saving the modified shortcut under a new name; for
example, Transparency Presentations. After creating the printing shortcut, simply select
it when printing on transparency film rather than changing the print settings each time.
To create a printing shortcut
1. On the File menu in your software application, click Print.
2. Make sure the HP All-in-One is the selected printer.
3. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
4. Click the Printing Shortcuts tab.
5. In the Printing Shortcuts list, click a printing shortcut.
The print settings for the selected printing shortcut are displayed.
6. Change the print settings to those you want in the new printing shortcut.
7. In the Type new shortcut name here box, type a name for the new printing shortcut,
and then click Save.
The printing shortcut is added to the list.
To delete a printing shortcut
1. On the File menu in your software application, click Print.
2. Make sure the HP All-in-One is the selected printer.
3. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
4. Click the Printing Shortcuts tab.
5. In the Printing Shortcuts list, click the printing shortcut that you want to delete.
6. Click Delete.
The printing shortcut is removed from the list.

Print

NOTE: Only the shortcuts that you have created can be deleted. The original HP
shortcuts cannot be deleted.

Printing shortcuts
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Perform special print jobs
In addition to supporting standard print jobs, the HP All-in-One can perform special jobs
such as printing borderless images, iron-on transfers, and posters.
This section contains the following topics:
•
•
•
•
•
•
•
•
•
•
•
•
•

Print a borderless image
Print a photo on photo paper
Create custom cd/dvd labels
Print using Maximum dpi
Print on both sides of the page
Print a multiple-page document as a booklet
Print multiple pages on a single sheet
Print a multiple-page document in reverse order
Reverse an image for iron-on transfers
Print on transparencies
Print a group of addresses on labels or envelopes
Print a poster
Print a Web page

Print a borderless image
Borderless printing lets you print to the top, bottom, and side edges of 10 x 15 cm (4 x 6
inch) HP Premium Plus Photo Papers with a tear-off tab. When you remove the tear-off
tab, the printed image is borderless and extends to the edges of the paper.
TIP: You can automatically adjust the settings in the Properties dialog box to print
a borderless 10 x 15 cm (4 x 6 inch) photo on HP Premium Plus Photo Paper. Click
the Printing Shortcuts tab, and then, in the Printing Shortcuts list, select Photo
printing-borderless. You can also set the options manually as described in the
following procedure.
To print a borderless image
1. Remove all paper from the input tray, and then load the photo paper print side down.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Resizing Options area, click the appropriate paper size from the Size list.
If a borderless image can be printed on the specified size, the Borderless check box
is enabled.
7. In the Basic options area, click a paper type in the Paper Type drop-down list.
NOTE: You cannot print a borderless image if the paper type is set to
Automatic or to a type of paper other than a photo paper.
Print
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8. Select the Borderless printing check box if it is not already checked.
If the borderless paper size and paper type are not compatible, the HP All-in-One
software displays an alert and allows you to select a different type or size.
9. Click OK, and then click Print or OK in the Print dialog box.
NOTE: Do not leave unused photo paper in the input tray. The paper might start
to curl, which could reduce the quality of your printout. Photo paper should be flat
before printing.
Related topics
Load 10 x 15 cm (4 x 6 inch) photo paper

Print a photo on photo paper
For high-quality photo printing, HP recommends you use HP Premium Plus Photo
Papers with the HP All-in-One.
You can also improve the quality of the photos you print with the HP All-in-One by
purchasing a photo print cartridge. With the tri-color print cartridge and photo print
cartridge installed, you have a six-ink system, which provides enhanced quality color
photos.

Print

To print a photo on photo paper
1. Remove all paper from the input tray, and then load the photo paper print side down.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Basic Options area, select the appropriate photo paper type from the Paper
Type drop-down list.
7. In the Resizing Options area, click the appropriate paper size from the Size list.
If the paper size and paper type are not compatible, the HP All-in-One software
displays an alert and allows you to select a different type or size.
8. In the Basic Options area, select a high print quality, such as Best or Maximum
dpi from the Print Quality drop-down list.
9. In the HP real life technologies area, click the Photo fix drop-down list and select
from the following options:
• Off: applies no HP real life technologies to the image.
• Basic: automatically focuses the image; moderately adjusts image sharpness.
• Full: automatically lightens dark images; automatically adjusts sharpness,
contrast, and focus of images; automatically removes red-eye.
10. Click OK to return to the Properties dialog box.
11. If you want to print the photo in black and white, click the Color tab and select the
Print in grayscale check box.
12. Click OK, and then click Print or OK in the Print dialog box.

Perform special print jobs
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NOTE: Do not leave unused photo paper in the input tray. The paper might start to
curl, which could reduce the quality of your printout. Photo paper should be flat before
printing.
Related topics
• Handle the print cartridges
• Work with print cartridges

Create custom cd/dvd labels
You can create custom labels for your CDs and DVDs on the HP All-in-One by following
the steps below. Or, to create custom CD and DVD labels online, go to www.hp.com and
follow the prompts.
To create custom CD/DVD labels
1. Make sure you have CD/DVD tattoo paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Paper Type drop-down list, click More, and then select HP CD/DVD tattoo
paper from the list.
7. Click OK, and then click Print or OK in the Print dialog box.

Print using Maximum dpi
Use Maximum dpi mode to print high-quality, sharp images.
To get the most benefit from Maximum dpi mode, use it to print high-quality images such
as digital photographs. When you select the Maximum dpi setting, the printer software
displays the optimized dots per inch (dpi) that the HP All-in-One will print.
Printing in Maximum dpi takes longer than printing with other settings and requires a
large amount of disk space.
NOTE: If a photo print cartridge is also installed, the print quality is enhanced. A
photo print cartridge can be purchased separately if it is not included with the HP Allin-One.
To print in Maximum dpi mode
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
Print
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5. Click the Features tab.
6. In the Paper Type drop-down list, click More, and then select the appropriate paper
type.
7. In the Print Quality drop-down list, click Maximum dpi.
NOTE: To view the maximum dpi that the HP All-in-One will print, click
Resolution.
8. Select any other print settings that you want, and then click OK.
Related topics
• Use a photo print cartridge
• Work with print cartridges

Print on both sides of the page
You can print two-sided pages with the HP All-in-One manually. When printing two-sided
pages, make sure to use paper that is thick enough so that images do not show through
to the other side.

Print

To print on both sides of the page
1. Load paper into the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Paper saving options area, select Manual from the Two-sided printing dropdown list.
7. For binding, do one of the following:
• For binding on the top like a notebook or calendar, select the Flip Pages Up check
box.
This causes the odd and even pages of your document to print opposite of each
other top-to-bottom. This ensures that the top of the page is always at the top of
the sheet when you flip the pages up in your bound document.

Perform special print jobs
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•

For binding on the side like a book or magazine, click to clear the Flip pages
up check box.
This causes the odd and even pages of your document to print opposite of each
other left-to-right. This ensures that the top of the page is always at the top of the
sheet when you turn the pages in your bound document.

8. Click OK, and then click Print or OK in the Print dialog box.
The HP All-in-One begins printing. Wait until all the odd-numbered pages are printed
before removing any of the printed pages from the output tray.
A dialog box displays instructions on the screen when it is time to process the second
side of your job. Do not click Continue in the dialog box until you have reloaded the
paper as instructed.
9. Follow the instructions that appear on your screen for reloading the paper to print on
the second side, and then click Continue.

Print a multiple-page document as a booklet
The HP All-in-One allows you to print your document as a small booklet, which you can
fold and then staple together.
For best results, design your document to fit on a multiple of four pages, such as an 8,
12, or 16-page program for a child's school play or for a wedding.
To print a multiple-page document as a booklet
1. Load paper into the input tray.
The paper should be thick enough that the images do not show through to the other
side.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Paper saving options area, select Manual from the Two-sided printing dropdown list.
7. Select the binding edge from the Booklet layout is list, as appropriate for your
language.
• If your language reads left-to-right, click Left edge binding.
• If your language reads right-to-left, click Right edge binding.
The Pages per sheet box is automatically set to two pages per sheet.
Print
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8. Click OK, and then click Print or OK in the Print dialog box.
The HP All-in-One begins printing.
A dialog box displays instructions on the screen when it is time to process the second
side of your job. Do not click Continue in the dialog box until you have reloaded the
paper as instructed in the following steps.
9. Wait until the HP All-in-One has stopped printing for several seconds before removing
any of the printed pages from the output tray.
If you remove the pages while the document is still printing, the pages might get out
of order.
10. Follow the instructions that appear on your screen for reloading the paper to print on
the second side, and then click Continue.
11. When the entire document has finished printing, fold the stack of paper in half, so that
the first page is on top, then staple the document along the crease.
TIP: For best results, use a saddle stapler, or a heavy-duty stapler with a long
reach to staple the booklet.
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Figure 7-1 Left-edge binding for left-to-right languages
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Figure 7-2 Right-edge binding for right-to-left languages
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Print multiple pages on a single sheet
You can print up to 16 pages on a single sheet of paper.
To print multiple pages on a single sheet
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Pages per sheet list, click 2, 4, 6, 8, 9, or 16.
7. In the Page Order list, click an appropriate page order option.
The sample output graphic is numbered to show how the pages will be ordered if you
select each option.
8. Click OK, and then click Print or OK in the Print dialog box.

Print a multiple-page document in reverse order
If the first page that prints is face-up at the bottom of the stack, this usually means you
need to put the printed pages in the correct order.

5
4
3
2
1

A better way is to print the document in reverse order so that the pages are stacked
correctly.

1
2
3
4
5

TIP: Set this option as a default setting so you do not have to remember to set it
every time you print a multiple-page document.
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To print a multiple-page document in reverse order
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Advanced tab.
6. Expand the Document Options list, and then expand the Layout Options list.
7. Click Page Order in the Layout Options list, and then click Front to Back.
NOTE: If you set your document to print on both sides of the page, the Front to
back option is not available. Your document will automatically print in the correct
order.
8. Click OK, and then click Print or OK in the Print dialog box.
When you are printing multiple copies, each set is printed completely before the next
set is printed.

Reverse an image for iron-on transfers
This feature reverses an image so you can use it for iron-on transfers. This feature is also
useful for transparencies when you want to make notations on the back of the
transparency without scratching the original.
To reverse an image for iron-on transfers
1. On the File menu in your software application, click Print.
2. Make sure the HP All-in-One is the selected printer.
3. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
4. Click the Features tab.
5. In the Basic options area, click HP Iron-on Transfer from the Paper Type list.
6. Click the Advanced tab.
7. Expand the Document Options, and then expand the Printer Features.
8. Set Mirror Image to On.
9. Click OK, and then click Print or OK in the Print dialog box.
NOTE: To prevent jams, manually feed the iron-on transfer sheets into the input
tray one sheet at a time.

Print on transparencies

Print

For the best results, HP recommends you use HP transparency products with the HP Allin-One.
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To print on transparencies
1. Load the transparency into the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Basic Options area, click the appropriate transparency type in the Paper
Type list.
TIP: If you want to make notations on the back of the transparencies and erase
them later without scratching the original, click the Advanced tab, and select the
Mirror Image check box.
7. In the Resizing Options area, click an appropriate size in the Size list.
8. Click OK, and then click Print or OK in the Print dialog box.
The HP All-in-One automatically waits for transparencies to dry before releasing
them. Ink dries slower on film than on plain paper. Make sure you allow enough time
for the ink to dry before handling the transparency.

Print a group of addresses on labels or envelopes
With the HP All-in-One, you can print on a single envelope, a group of envelopes, or label
sheets designed for inkjet printers.
To print a group of addresses on labels or envelopes
1. Print a test page on plain paper first.
2. Place the test page on top of the label sheet or envelope, and hold both up to the
light. Check the spacing for each block of text. Make adjustments as needed.
3. Load the labels or envelopes into the input tray.
CAUTION: Do not use envelopes with clasps or windows. They can get stuck in
the rollers and cause paper jams.
4. If you are printing on envelopes, do the following:
a. Display the print settings, and click the Features tab.
b. In the Resizing Options area, click the appropriate envelope size in the Size list.
5. Click OK, and then click Print or OK in the Print dialog box.
Related topics
Load envelopes
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Print a poster
You can create a poster by printing a document on multiple pages. The HP All-in-One
prints dotted lines on some pages to indicate where to trim the pages before taping them
together.

To print a poster
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the HP All-in-One is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Advanced tab.
6. Expand the Document Options, and then expand the Printer Features.
7. In the Poster Printing drop-down list, click either 2x2 (4 sheets); 3x3 (9 sheets);
4x4 (16 sheets); or 5x5 (25 sheets).
This selection tells the HP All-in-One to enlarge your document so that it fits on 4, 9,
16, or 25 pages.
If your original document is multiple pages, each of those pages will be printed on 4,
9, 16, or 25 pages. For example, if you have a one-page original and you select 3x3,
you will get 9 pages; if you select 3x3 for a two-page original, 18 pages will print.
8. Click OK, and then click Print or OK in the Print dialog box.
9. After the poster has printed, trim the edges of the sheets and tape the sheets together.

Print a Web page

Print

You can print a Web page from your Web browser on the HP All-in-One.
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To print a Web page
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your Web browser, click Print.
The Print dialog box appears.
3. Make sure the HP All-in-One is the selected printer.
4. If your Web browser supports it, select the items on the Web page that you want to
include in the printout.
For example, in Internet Explorer, click the Options tab to select options such as As
laid out on screen, Only the selected frame, and Print all linked documents.
5. Click Print or OK to print the Web page.
TIP: To print Web pages correctly, you might need to set your print orientation to
Landscape.

Stop a print job
Although you can stop a print job from either the HP All-in-One or the computer, HP
recommends you stop it from the HP All-in-One for best results.
NOTE: Although most software applications designed for Windows use the
Windows print spooler, your software application might not use the spooler. An
example of a software application that does not use the Windows print spooler is
PowerPoint in Microsoft Office 97.
If you cannot cancel your print job by using one of the following procedures, consult
the instructions for canceling background printing in the online help for your software
application.

To stop a print job from the HP All-in-One
▲ Press Cancel on the control panel. If the print job does not stop, press Cancel again.
It can take a few moments for printing to be cancelled.
To stop a print job from the computer
▲ You can cancel most print jobs from the print queue. For more information about how
to do this, see the Windows Help.
Related topics
Control panel buttons

Resume a print job
If an error occurs while printing, you may need to resume the job from the HP All-in-One
or the computer after you address the error.
To resume a print job from the control panel
▲ On the control panel, press Resume.
Print
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To resume a print job from the computer
▲ You can resume some print jobs from the print queue. For more information about
how to do this, see the Windows Help.

Print

Related topics
Control panel buttons

Resume a print job
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Use the copy features
The HP All-in-One allows you to produce high-quality color and black-and-white copies
on a variety of paper types. You can enlarge or reduce the size of an original to fit a
specific paper size, adjust the copy quality, and make high-quality copies of photos,
including borderless copies.
This section contains the following topics:
•
•
•
•
•
•
•

Make a copy
Set the copy paper type
Change copy speed
Make multiple copies of the same original
Copy a two-page black-and-white document
Make a 10 x 15 cm (4 x 6 inch) borderless copy of a photo
Stop copying

Make a copy
You can make quality copies from the control panel.
To make a copy from the control panel
1. Make sure you have paper loaded in the input tray.
2. Place your original with the side you want to copy or scan face down on the left front
corner of the glass.
TIP: For quality copies, ensure that the scanner glass is clean and that there are
no foreign materials adhering to it. For more information, see Clean the glass.
3. Press the Paper Type button to set the paper type.
4. Press Start Copy Black or Start Copy Color.
Related topics
Control panel buttons

Set the copy paper type
You can set the paper type for copying to either Plain or Photo.
To set the paper type for copies
1. Make sure you have paper loaded in the input tray.
2. Place your original with the side you want to copy or scan face down on the left front
corner of the glass.

Use the copy features
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3. Press the Paper Type button to set the paper type.
Copies made on photo paper are automatically made using Best quality. When Photo
Paper Type is selected, the HP All-in-One enlarges or shrinks the original to fit within
the copy margin of the detected paper size.
Copies made on plain paper are automatically made using Normal quality. When the
Plain Paper Type is selected, the HP All-in-One makes an exact copy of the original
placed on the scanner glass.
NOTE: Ensure that the scanner glass is clean for the copy function to work
properly.
4. Press Start Copy Black or Start Copy Color.
Refer to the following table to determine which paper type setting to choose based on the
paper loaded in the input tray.
Paper type

Control panel setting

Copier paper or letterhead

Plain

HP Bright White Paper

Plain

HP Premium Plus Photo Paper, Glossy

Photo

HP Premium Plus Photo Paper, Matte

Photo

HP Premium Plus 4 x 6 inch Photo Paper

Photo

HP Photo Paper

Photo

HP Everyday Photo Paper

Photo

HP Everyday Photo Paper, Semi Gloss

Photo

Other photo paper

Photo

HP Premium Paper

Plain

HP All-in-One Paper

Plain

HP Printing Paper

Plain

Other inkjet paper

Plain

Legal

Plain

Related topics
Control panel buttons

Change copy speed
Copies made from the control panel on regular, plain paper automatically use Normal
quality.
You can make a Fast copy using the instructions below. Fast copies faster with
comparable quality text, but the graphics quality might be lower. Fast copies use less ink
and extend the life of your print cartridges.
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To make a Fast copy
1. Make sure you have paper loaded in the input tray.
2. Place your original with the side you want to copy or scan face down on the left front
corner of the glass.
TIP: For quality copies, ensure that the scanner glass is clean and that there are
no foreign materials adhering to it. For more information, see Clean the glass.
3. Press the Paper Type button to set the paper type.
4. Press and hold down the Scan button, and then press either Start Copy Black or
Start Copy Color.
Related topics
Control panel buttons
Set the copy paper type

Make multiple copies of the same original
You can set the number of copies from the control panel or from the software that you
installed with the HP All-in-One.
To make multiple copies of an original from the control panel
1. Make sure you have paper loaded in the input tray.
2. Place your original with the side you want to copy or scan face down on the left front
corner of the glass.
TIP: For quality copies, ensure that the scanner glass is clean and that there are
no foreign materials adhering to it. For more information, see Clean the glass.
3. Press the Paper Type button to set the paper type.

Make multiple copies of the same original
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NOTE: Fast or Normal are not available when the paper type is set to Photo.
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4. Press the Start Copy Black or Start Copy Color button to increase the number of
copies up to a maximum of 9 (varies by model).

Use the copy features

NOTE: The HP All-in-One waits very briefly for another button press. Pause for
a while before pressing the Start Copy Black or Start Copy Color button again
to start the copy job.
TIP: Use the software that you installed with the HP All-in-One to set the number
of copies higher than 9.
5. Press Start Copy Black or Start Copy Color.
In this example, the HP All-in-One makes six copies of the original 10 x 15 cm (4 x 6
inch) photo.

Related topics
Control panel buttons

Copy a two-page black-and-white document
You can use the HP All-in-One to copy a single- or multiple-page document in color or
black and white. In this example, the HP All-in-One is used to copy a two-page blackand-white original.

To copy a two-page document from the control panel
1. Make sure you have paper loaded in the input tray.
2. Place your original with the side you want to copy or scan face down on the left front
corner of the glass.
3. Press the Paper Type button to set the paper type.
4. Press Start Copy Black.
5. Remove the first page from the glass and load the second page.
6. Press Start Copy Black.
Related topics
Control panel buttons
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Make a 10 x 15 cm (4 x 6 inch) borderless copy of a photo

To make a borderless copy of a photo from the control panel
1. Load 10 x 15 cm (4 x 6 inch) tabbed photo paper in the input tray.
NOTE: To make a borderless copy, you must use tabbed photo paper.
2. Load your original photo with the side you want to print on face down on the left front
corner of the glass.
3. Press Paper Type to select the Photo paper type.
NOTE: When the Photo paper type is selected, the HP All-in-One defaults to
making a borderless copy with a 10 x 15 cm (4 x 6 inch) original.
4. Press Start Copy Color.
The HP All-in-One makes a borderless copy of your original photo, as shown below.

Related topics
Control panel buttons

Stop copying
To stop copying
▲ Press Cancel on the control panel.
Related topics
Control panel buttons

Make a 10 x 15 cm (4 x 6 inch) borderless copy of a photo
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To make a borderless copy of a photo, use the 10 x 15 cm (4 x 6 inch) HP Premium Plus
Photo Paper with a tear-off tab. When you remove the tear-off tab, the output is a
borderless copy of the image that extends to the edges of the paper.

Chapter 8
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Use the scan features
Scanning is the process of converting text and pictures into an electronic format for your
computer. You can scan almost anything (photos, magazine articles and text documents)
on the HP All-in-One.
You can use the scanning features of the HP All-in-One to do the following:
•
•
•
•
•

Scan text from an article into your word processor and quote it in a report.
Print business cards and brochures by scanning a logo and using it in your publishing
software.
Send photos to friends and relatives by scanning your favorite prints and including
them in e-mail messages.
Create a photographic inventory of your house or office.
Archive treasured photos in an electronic scrapbook.
NOTE: If you are using the HP Photosmart Software, the Optical Character
Recognition (OCR) software might not be installed on your computer. To install the
OCR software, you must re-insert the software disk and select OCR under the
Custom installation options.

This section contains the following topics:
Scan an original
Edit a scanned preview image
Edit a scanned image
Edit a scanned document
Stop scanning

Scan

•
•
•
•
•

Scan an original
For original documents or images placed on the glass, you can start a scan from your
computer or from the HP All-in-One. This section explains the second option: how to scan
from the control panel of the HP All-in-One to a computer.
To use the scan features, the HP All-in-One and computer must be connected and turned
on. The HP Photosmart Software must also be installed and running on your computer
prior to scanning. To verify that the HP Photosmart Software is running on a Windows
computer, look for the HP Digital Imaging Monitor icon in the system tray at the lower
right side of the screen, near the time.
NOTE: Closing the HP Digital Imaging Monitor icon in the Windows system tray
can cause the HP All-in-One to lose some of its scan functionality. If this happens,
you can restore full functionality by restarting your computer or by starting the
HP Photosmart Software.
The HP Photosmart Software that you installed on your computer has many tools that
you can use to edit and print your scanned image. You can improve the overall image
quality by adjusting the brightness, sharpness, color tone, or saturation. You can also
crop, straighten, rotate, or resize the image. When the scanned image looks just the way

Use the scan features
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you want it, you can open it in another application, send it through e-mail, save it to a file,
or print it.

To scan to a computer
1. Place your original with the side you want to copy or scan face down on the left front
corner of the glass.
TIP: For quality copies, ensure that the scanner glass is clean and that there are
no foreign materials adhering to it. For more information, see Clean the glass.
2. Press Scan.
If the original is a document, the HP All-in-One scans it automatically. If the original
is a photo, a preview image of the scan appears on your computer, where you can
edit it. Any edits that you make apply to the current scan session only.
The HP Photosmart Software has many tools that you can use to edit your scanned
image. You can improve the overall image quality by adjusting the brightness,
sharpness, color tone, or saturation. You can also crop, rotate, or resize the image.
3. Make any edits to the preview image, and then click Accept when you are finished.
Related topics
Control panel buttons
Scan

Edit a scanned preview image
You can use the tools in the HP Scanning software to modify a preview image. Any
changes that you make, such as brightness, image type, resolution, and more apply only
to this scan session.
You can make additional changes in the HP Photosmart software after the image is
scanned.
Related topics
Use the HP Photosmart software

Edit a scanned image
You can edit a scanned image, such as a photo or graphic, using the software you
installed with the HP All-in-One. Using this software, you can rotate or crop the image,
as well as adjust the brightness, contrast, and color saturation.
NOTE: If you are using the HP Photosmart Software, the Optical Character
Recognition (OCR) software might not be installed on your computer. To install the
OCR software, you must re-insert the software disk and select OCR under the
Custom installation options.
Related topics
Use the HP Photosmart software
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Edit a scanned document
You can edit a scanned document using your Optical Character Recognition (OCR)
software. Scanning text using OCR software enables you to bring the content of magazine
articles, books, and other printed matter into your favorite word processor and many other
applications as editable text. Learning to use OCR software correctly is important if you
want to obtain the best results. Do not expect scanned text documents to be letter-perfect
the first time you use your OCR software. Using OCR software is an art that takes time
and practice to master.
NOTE: If you are using the HP Photosmart Software, the Optical Character
Recognition (OCR) software might not be installed on your computer. To install the
OCR software, you must re-insert the software disk and select OCR under the
Custom installation options.
Related topics
Use the HP Photosmart software

Stop scanning

Scan

To stop scanning
▲ Press Cancel on the control panel.
Related topics
Control panel buttons

Edit a scanned document
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10 Maintain the HP All-in-One
The HP All-in-One requires little maintenance. Sometimes you might want to clean the
glass and lid backing to remove surface dust and ensure that your copies and scans
remain clear. You will also need to replace, align, or clean your print cartridges from time
to time. This section provides instructions for keeping the HP All-in-One in top working
condition. Perform these simple maintenance procedures as necessary.
This section contains the following topics:
•
•
•

Clean the HP All-in-One
Print a self-test report
Work with print cartridges

Clean the HP All-in-One
To ensure that your copies and scans remain clear, you might need to clean the glass
and lid backing. You might also want to dust the exterior of the HP All-in-One.
This section contains the following topics:
•
•
•

Clean the exterior
Clean the glass
Clean the lid backing

Use a soft cloth or slightly moistened sponge to wipe dust, smudges, and stains off the
case. The interior of the HP All-in-One does not require cleaning. Keep fluids away from
the control panel and the interior of the HP All-in-One.
CAUTION: To avoid damage to the exterior of the HP All-in-One, do not use alcohol
or alcohol-based cleaning products.

Clean the glass
Fingerprints, smudges, hair, and dust on the main glass surface slow down performance
and affect the accuracy of the copy and scan features.
To clean the glass
1. Turn off the HP All-in-One, unplug the power cord, and raise the lid.
2. Clean the glass with a soft cloth or sponge slightly moistened with a nonabrasive
glass cleaner.
CAUTION: Do not use abrasives, acetone, benzene, or carbon tetrachloride on
the glass, since they can damage it. Do not place or spray liquid directly on the
glass. The liquid might seep under the glass and damage the device.
3. Dry the glass with a dry, soft, lint-free cloth to prevent spotting.
4. Plug in the power cord, and then turn on the HP All-in-One.

Maintain the HP All-in-One

59

Maintain the HP All-in-One

Clean the exterior

Chapter 10

Clean the lid backing
Minor debris can accumulate on the white document backing located underneath the lid
of the HP All-in-One.
To clean the lid backing
1. Turn off the HP All-in-One, unplug the power cord, and raise the lid.
2. Clean the white document backing with a soft cloth or sponge slightly moistened with
a mild soap and warm water.
Wash the backing gently to loosen debris. Do not scrub the backing.
3. Dry the backing with a dry, soft, lint-free cloth.
CAUTION: Do not use paper-based wipes, as these might scratch the backing.
4. If further cleaning is needed, repeat the previous steps using isopropyl (rubbing)
alcohol, and wipe the backing thoroughly with a damp cloth to remove any residual
alcohol.
CAUTION: Be careful not to spill alcohol on the glass or exterior of the HP Allin-One, as this might damage the device.
5. Plug in the power cord, and then turn on the HP All-in-One.

Print a self-test report
If you are experiencing problems with printing, print a self-test report before you replace
the print cartridges. This report provides useful information on several aspects of your
device, including your print cartridges.

Maintain the HP All-in-One

To print a self-test report
1. Load letter or A4 unused plain white paper into the input tray.
2. Press and hold the Cancel button and then press the Start Copy Color button.
The HP All-in-One prints a self-test report, which might indicate the source of the
printing problem. A sample of the ink test area of the report is shown below.
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3. Make sure the test patterns show a complete grid and the thick color lines are
complete.
• If more than a few lines in a pattern are broken, this might indicate a problem with
the nozzles. You might need to clean the print cartridges.
• If the black line is missing, faded, streaked, or shows lines, this might indicate a
problem with the black or photo print cartridge in the right slot.
• If any of the color lines are missing, faded, streaked, or show lines, this might
indicate a problem with the tri-color print cartridge in the left slot.
Related topics
• Clean the print cartridges
• Replace the print cartridges
• Control panel buttons

Work with print cartridges
To ensure the best print quality from the HP All-in-One, you will need to perform some
simple maintenance procedures. This section provides guidelines for handling the print
cartridges and instructions for replacing, aligning, and cleaning the print cartridges.
You might also need to check your print cartridges if the Check Print Cartridge light is on.
This might mean that the print cartridges are not installed properly or are missing, the
plastic tape has not been removed from the print cartridges, the print cartridges are out
of ink, or the print carriage is blocked.
This section contains the following topics:
Handle the print cartridges
Check the estimated ink levels
Replace the print cartridges
Use ink-backup mode
Use a photo print cartridge
Store the print cartridges
Align the print cartridges
Clean the print cartridges
Clean the print cartridge contacts
Clean the area around the ink nozzles
Remove ink from your skin and clothing

Maintain the HP All-in-One
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•
•
•
•

Work with print cartridges
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Handle the print cartridges
Before you replace or clean a print cartridge, you should know the part names and how
to handle the print cartridges.

1

Copper-colored contacts

2

Plastic tape with pink pull tab (must be removed before installing)

3

Ink nozzles under tape

Hold the print cartridges by their black plastic sides, with the label on top. Do not touch
the copper-colored contacts or the ink nozzles.

Maintain the HP All-in-One

NOTE: Handle the print cartridges carefully. Dropping or jarring cartridges can cause
temporary printing problems, or even permanent damage.

Check the estimated ink levels
You can easily check the ink supply level to determine how soon you might need to
replace a print cartridge. The ink supply level shows an estimate of the amount of ink
remaining in the print cartridges.
TIP: You can also print a self-test report to see if your print cartridges might need to
be replaced.
NOTE: The HP All-in-One can only detect the ink levels for genuine HP ink. The ink
levels in print cartridges that are refilled or have been used in other devices might not
register accurately.
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NOTE: Ink from the cartridges is used in the printing process in a number of different
ways, including in the initialization process, which prepares the device and cartridges
for printing, and in printhead servicing, which keeps print nozzles clear and ink flowing
smoothly. In addition, some residual ink is left in the cartridge after it is used. For more
information, see www.hp.com/go/inkusage.
To check the ink levels from the HP Photosmart Software
1. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.
NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.
The Printer Toolbox appears.
2. Click the Estimated Ink Level tab.
The estimated ink levels for the print cartridges appear.
Related topics
Print a self-test report

Replace the print cartridges
Follow these instructions when the ink level is low.

When you receive a low-ink warning message, make sure you have a replacement print
cartridge available. You should also replace the print cartridges when you see faded text
or if you experience print quality issues related to the print cartridges.
To order print cartridges for the HP All-in-One, go to www.hp.com/buy/supplies. If
prompted, choose your country/region, follow the prompts to select your product, and
then click one of the shopping links on the page.
Choose the right cartridge combination
Choose the best combination of cartridges for your print job:
•
•

Everyday printing: Use a black cartridge along with a tri-color cartridge.
Color photos: Use a photo cartridge along with a tri-color cartridge.

Work with print cartridges
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NOTE: When the ink level for the print cartridge is low, a message appears on your
computer screen. You can also check the ink levels by using the software installed
with the HP All-in-One.

Chapter 10

To replace the print cartridges
1. Make sure the HP All-in-One is on.
CAUTION: If the HP All-in-One is off when you open the print cartridge door to
access the print cartridges, the HP All-in-One will not release the cartridges for
changing. You might damage the HP All-in-One if the print cartridges are not
docked safely when you try to remove them.
2. Open the print cartridge door.
The print carriage should move to the center of the HP All-in-One. If the print carriage
does not move to the center, turn the HP All-in-One off, and then on.

3. Wait until the print carriage is idle and silent, and then lightly press down on a print
cartridge to release it.
If you are replacing the tri-color print cartridge, remove the print cartridge from the
slot on the left.
If you are replacing the black or photo print cartridge, remove the print cartridge from
the slot on the right.
Maintain the HP All-in-One
1

Print cartridge slot for the tri-color print cartridge

2

Print cartridge slot for the black and photo print cartridges

4. Pull the print cartridge toward you out of its slot.
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5. If you are removing the black print cartridge in order to install the photo print cartridge,
store the black print cartridge in the print cartridge protector or an airtight plastic
container.
If you are removing the print cartridge because it is low or out of ink, recycle the print
cartridge. The HP Inkjet Supplies Recycling Program is available in many countries/
regions, and lets you recycle used print cartridges free of charge. For more
information, go to the following Web site:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/inkjet.html
6. Remove the new print cartridge from its packaging, being careful to touch only the
black plastic. Gently remove the pastic tape using the pink pull tab.

1

Copper-colored contacts

2

Plastic tape with pink pull tab (must be removed before installing)

3

Ink nozzles under tape

Maintain the HP All-in-One

CAUTION: Do not touch the copper-colored contacts or ink nozzles. Touching
these parts can result in clogs, ink failure, and bad electrical connections.

7. Slide the new print cartridge forward into the empty slot. Then gently push on the
upper part of the print cartridge forward until it clicks into the socket.
If you are installing the tri-color print cartridge, slide it into the left slot.
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If you are installing a black or photo print cartridge, slide it into the right slot.

8. Close the print cartridge door.

9. If the print cartridge alignment sheet prints, load it on the left front corner of the glass
with the top of the page to the left.

Maintain the HP All-in-One

10. Press the Scan button.
The HP All-in-One aligns the print cartridges. Recycle or discard the print cartridge
alignment sheet.
Related topics
• Check the estimated ink levels
• Control panel buttons
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Use ink-backup mode
Use the ink-backup mode to operate the HP All-in-One with only one print cartridge. The
ink-backup mode is initiated when a print cartridge is removed from the print cartridge
cradle.
NOTE: When the HP All-in-One operates in ink-backup mode, a message is
displayed on screen. If the message is displayed and two print cartridges are installed
in the device, verify that the protective piece of plastic tape has been removed from
each print cartridge. When plastic tape covers the print cartridge contacts, the device
cannot detect that the print cartridge is installed.
This section contains the following topics:
•
•

Ink-backup mode output
Exit ink-backup mode

Ink-backup mode output
Printing in ink-backup mode slows the HP All-in-One and affects the quality of printouts.
Installed print cartridge

Result

Black print cartridge

Colors print as grayscale.

Tri-color print cartridge

Colors print but black is grayed and is not a true black.

Photo print cartridge

Colors print as grayscale.

Exit ink-backup mode
Install two print cartridges in the HP All-in-One to exit ink-backup mode.
For information about installing an ink cartridge, see Replace the print cartridges.

Use a photo print cartridge
You can optimize the quality of the color photos you print and copy with the HP All-inOne by purchasing a photo print cartridge. Remove the black print cartridge and insert
the photo print cartridge in its place. With the tri-color print cartridge and photo print
cartridge installed, you have a six-ink system, which provides enhanced quality color
photos.
When you want to print regular text documents, swap the black print cartridge back in.
Use a print cartridge protector or an airtight plastic container to keep your print cartridge
secure when it is not being used.
Related topics
• Replace the print cartridges
• Control panel buttons
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NOTE: HP does not recommend using the photo print cartridge for ink-backup mode.
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Store the print cartridges
Follow these guidelines to maintain and store HP print cartridges and to ensure consistent
print quality.
•
•

Print cartridge storage and handling
Print cartridge protector

Print cartridge storage and handling
Follow these guidelines to help maintain HP print cartridges and ensure consistent print
quality:
•
•

•

•

Install the cartridge on or before the Install by date, which is printed on the cartridge
package.
When you remove a print cartridge from the device, store it in an airtight plastic
container to prevent the ink from drying out. If you are storing a photo print cartridge,
you can use a print cartridge protector. For more information, see Print cartridge
protector.
Keep all unused print cartridges in their original sealed packages until they are
needed. Store print cartridges at room temperature (15–35 degrees C or 59–95
degrees F).
Do not remove the plastic tape covering the ink nozzles until you are ready to install
the print cartridge in the device. If the plastic tape has been removed from the print
cartridge, do not attempt to reattach it. Reattaching the tape damages the print
cartridge.
CAUTION: Always turn the HP All-in-One off with the Power button before you
unplug the power cord or turn off a power strip. This allows the device to store the
print cartridges properly. When you store the HP All-in-One, always leave the active
print cartridges inside the device.

Maintain the HP All-in-One

Print cartridge protector
In some countries/regions, when you purchase a photo print cartridge, you might also
receive a print cartridge protector. If a print cartridge protector is not available, you can
use an airtight plastic container to protect your print cartridge.
The print cartridge protector is designed to keep a print cartridge secure and prevent it
from drying out when it is not being used. Whenever you remove a print cartridge from
the HP All-in-One with the intention of using it again later, store it in the print cartridge
protector. For example, store the black print cartridge in a print cartridge protector if you
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are removing it so you can print high-quality photos with the photo and tri-color print
cartridges.
To insert a print cartridge into the print cartridge protector
▲ Place the print cartridge into the print cartridge protector at a slight angle and snap it
securely into place.

Align the print cartridges
The HP All-in-One prompts you to align cartridges every time you install or replace a print
cartridge. You can also align the print cartridges at any time from the control panel or by
using the software you installed with the HP All-in-One. Aligning the print cartridges
ensures high-quality output.
NOTE: If you remove and reinstall the same print cartridge, the HP All-in-One will
not prompt you to align the print cartridges. The HP All-in-One remembers the
alignment values for that print cartridge, so you do not need to realign the print
cartridges.
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To remove the print cartridge from the print cartridge protector
▲ Press down on the top of the print cartridge protector to release the print cartridge,
then gently remove the print cartridge out of the print cartridge protector.
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To align newly installed print cartridges
1. Make sure you have letter or A4 unused plain white paper loaded in the input tray.
The HP All-in-One prints a print cartridge alignment sheet.
NOTE: If you have colored paper loaded in the input tray when you align the print
cartridges, the alignment will fail. Load unused plain white paper into the input
tray, and then try the alignment again.
If the alignment fails again, you might have a defective sensor or print cartridge.
Contact HP Support. Go to www.hp.com/support. If prompted, choose your
country/region, and then click Contact HP for information on calling for technical
support.
2. Load the print cartridge alignment sheet print side down on the left front corner of the
glass with the top of the page to the left.
3. Press the Scan button.
The HP All-in-One aligns the print cartridges. Recycle or discard the print cartridge
alignment sheet.
To align the print cartridges from the HP Photosmart Software
1. Load letter or A4 unused plain white paper into the input tray.
NOTE: If you have colored paper loaded in the input tray when you align the print
cartridges, the alignment will fail. Load unused plain white paper into the input
tray, and then try the alignment again.
If the alignment fails again, you might have a defective sensor or print cartridge.
Contact HP Support. Go to www.hp.com/support. If prompted, choose your
country/region, and then click Contact HP for information on calling for technical
support.
Maintain the HP All-in-One

2. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.
NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.
3.
4.
5.
6.

The Printer Toolbox appears.
Click the Device Services tab.
Click Align the Print Cartridges.
The HP All-in-One prints a print cartridge alignment sheet.
Load the print cartridge alignment sheet print side down on the left front corner of the
glass.
Press the Scan button.
The HP All-in-One aligns the print cartridges. Recycle or discard the print cartridge
alignment sheet.

Related topics
Control panel buttons
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Clean the print cartridges
Use this feature when the self-test report shows streaking, white lines through any of the
lines of color or when a color is muddy after installing a print cartridge for the first time.
Do not clean print cartridges unnecessarily, as this wastes ink and shortens the life of the
ink nozzles.
To clean the print cartridges from the HP Photosmart Software
1. Load letter, A4, or legal unused plain white paper into the input tray.
2. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.
NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.
The Printer Toolbox appears.
3. Click the Device Services tab.
4. Click Clean the Print Cartridges.
5. Follow the prompts until you are satisfied with the quality of the output, and then click
Done.
If copy or print quality still seems poor after you clean the print cartridges, try cleaning
the print cartridge contacts before replacing the affected print cartridge.

Clean the print cartridge contacts
Clean the print cartridge contacts if you get repeated messages on your computer screen
prompting you to check a print cartridge after you already have cleaned or aligned the
print cartridges, or if the Check Print Cartridge light is blinking.
Before cleaning the print cartridge contacts, remove the print cartridge and verify that
nothing is covering the print cartridge contacts, then reinstall the print cartridge. If you
continue to get messages to check the print cartridges, clean the print cartridge contacts.
Make sure you have the following materials available:
•

Dry foam rubber swabs, lint-free cloth, or any soft material that will not come apart or
leave fibers.
TIP: Coffee filters are lint-free and work well for cleaning print cartridges.

•

Distilled, filtered, or bottled water (tap water might contain contaminants that can
damage the print cartridges).
CAUTION: Do not use platen cleaners or alcohol to clean the print cartridge
contacts. These can damage the print cartridge or the HP All-in-One.
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Related topics
• Clean the print cartridge contacts
• Replace the print cartridges

Chapter 10

To clean the print cartridge contacts
1. Turn on the HP All-in-One and open the print cartridge door.
The print carriage moves to the center of the HP All-in-One.
2. Wait until the print carriage is idle and silent, and then unplug the power cord from
the back of the HP All-in-One.
3. Lightly press down on the print cartridge to release it, and then pull it toward you out
of the slot.
NOTE: Do not remove both print cartridges at the same time. Remove and clean
each print cartridge one at a time. Do not leave a print cartridge outside the HP Allin-One for more than 30 minutes.
4. Inspect the print cartridge contacts for ink and debris buildup.
5. Dip a clean foam rubber swab or lint-free cloth into distilled water, and squeeze any
excess water from it.
6. Hold the print cartridge by its sides.
7. Clean only the copper-colored contacts. Allow the print cartridges to dry for
approximately ten minutes before reinserting.
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1

Copper-colored contacts

2

Ink nozzles (do not clean)

8. Slide the print cartridge back into the slot. Push the print cartridge forward until it clicks
into place.
9. Repeat if necessary for the other print cartridge.
10. Gently close the print cartridge door and plug the power cord into the back of the
HP All-in-One.
Related topics
• Clean the area around the ink nozzles
• Replace the print cartridges

Clean the area around the ink nozzles
If the HP All-in-One is used in a dusty environment, a small amount of debris might
accumulate inside the device. This debris can include dust, hair, carpet, or clothing fibers.
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When debris gets on the print cartridges, it can cause ink streaks and smudges on printed
pages. Ink streaking can be corrected by cleaning around the ink nozzles as described
here.
NOTE: Clean the area around the ink nozzles only if you continue to see streaks
and smudges on your printed pages after you have already cleaned the print
cartridges by using the software you installed with the HP All-in-One.
Make sure you have the following materials available:
•

Dry foam rubber swabs, lint-free cloth, or any soft material that will not come apart or
leave fibers.
TIP: Coffee filters are lint-free and work well for cleaning print cartridges.

•

Distilled, filtered, or bottled water (tap water might contain contaminants that can
damage the print cartridges).
CAUTION: Do not touch the copper-colored contacts or ink nozzles. Touching
these parts can result in clogs, ink failure, and bad electrical connections.

NOTE: Do not remove both print cartridges at the same time. Remove and clean
each print cartridge one at a time. Do not leave a print cartridge outside the HP Allin-One for more than 30 minutes.
4. Place the print cartridge on a piece of paper with the ink nozzles facing up.
5. Lightly moisten a clean foam rubber swab with distilled water.
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To clean the area around the ink nozzles
1. Turn on the HP All-in-One and open the print cartridge door.
The print carriage moves to the center of the HP All-in-One.
2. Wait until the print carriage is idle and silent, and then unplug the power cord from
the back of the HP All-in-One.
3. Lightly press down on the print cartridge to release it, and then pull it toward you out
of the slot.

Chapter 10

6. Clean the face and edges around the ink nozzle area with the swab, as shown below.

1

Nozzle plate (do not clean)

2

Face and edges around the ink nozzle area

CAUTION: Do not clean the nozzle plate.
7. Slide the print cartridge back into the slot. Push the print cartridge forward until it clicks
into place.
8. Repeat if necessary for the other print cartridge.
9. Gently close the print cartridge door and plug the power cord into the back of the
HP All-in-One.
Related topics
Clean the print cartridges

Remove ink from your skin and clothing
Maintain the HP All-in-One

Follow these instructions to remove ink from your skin and clothing:
Surface

Remedy

Skin

Wash the area with an abrasive soap.

White fabric

Wash the fabric in cold water and use chlorine bleach.

Color fabric

Wash the fabric in cold water and use sudsy ammonia.

CAUTION: Always use cold water to remove ink from fabric. Warm or hot water can
set the ink into the fabric.
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11 Shop for printing supplies
You can order HP products, such as recommended types of paper and print cartridges,
online from the HP Web site.
This section contains the following topics:
•
•
•

Order paper or other media
Order print cartridges
Order other supplies

Order paper or other media
To order HP papers and other supplies, such as HP Premium Photo Papers or HP Allin-One Paper, go to www.hp.com/buy/supplies. If prompted, choose your country/region,
follow the prompts to select your product, and then click one of the shopping links on the
page.

Order print cartridges
For a list of print cartridge numbers, see the printed documentation that came with the
HP All-in-One. You can also use the software that came with the HP All-in-One to find
out the reorder number for all the print cartridges. You can order print cartridges online
from the HP Web site. Additionally, you can contact a local HP reseller to find out the
correct print cartridge reorder numbers for your device and purchase print cartridges.
To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted,
choose your country/region, follow the prompts to select your product, and then click one
of the shopping links on the page.
NOTE: At this time, some portions of the HP Web site are available in English only.
NOTE: Ordering print cartridges online is not supported in all countries/regions. If it
is not supported in your country/region, contact a local HP reseller for information
about purchasing print cartridges.

NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.
2. Click the Estimated Ink Levels tab.
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To order print cartridges through the HP Photosmart Software
1. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.

Chapter 11

3. Click Print Cartridge Ordering Information.
The print cartridge reorder numbers appear.
4. Click Order Online.
HP sends detailed printer information, including model number, serial number, and
ink supply levels, to an authorized online reseller. The supplies you need are
preselected; you can change quantities, add or remove items, and then check out.

Order other supplies
To order other supplies, such as HP Photosmart Software, a copy of the Setup Guide or
other printed documentation, or other customer-replaceable parts, call the phone number
for your country/region.
Country/region

Number for ordering

Asia Pacific (except for Japan)

65 272 5300

Australia

1300 721 147

Europe

+49 180 5 290220 (Germany)
+44 870 606 9081 (U.K.)

New Zealand

0800 441 147

South Africa

+27 (0)11 8061030

U.S. and Canada

1-800-474-6836 (1-800-HP-INVENT)

To order supplies in other countries/regions not listed in the table, go to www.hp.com/
support. If prompted, choose your country/region, and then click Contact HP for
information on calling for technical support.
NOTE: At this time, some portions of the HP Web site are available in English only.
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12 Troubleshooting
This section contains the following topics:
Troubleshooting tips
Hardware setup troubleshooting
Software installation troubleshooting
Print cartridge troubleshooting
Print quality troubleshooting
Print troubleshooting
Copy troubleshooting
Scan troubleshooting
Errors
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•
•
•
•
•
•
•
•
•

Troubleshooting tips
This section contains the following topics:
•
•
•
•

Communication problems over a USB connection
Information on paper
Clear paper jams
View the Readme file

Communication problems over a USB connection
If the HP All-in-One and computer are not communicating with each other, try the
following:
•

•

•

Look at the On light located on the front of the HP All-in-One. If it is not lit, the HP Allin-One is turned off. Make sure the power cord is firmly connected to the HP All-inOne and plugged into a power outlet. Press the On button to turn on the HP All-inOne.
Check the USB cable. If you are using an older cable, it might not be working properly.
Try connecting it to another product to see if the USB cable works. If you experience
problems, the USB cable might need to be replaced. Also verify that the cable does
not exceed 3 meters (9.8 feet) in length.
Check the connection from the HP All-in-One to your computer. Verify that the USB
cable is securely plugged into the USB port on the back of the HP All-in-One. Make
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sure the other end of the USB cable is plugged into a USB port on your computer.
After the cable is connected properly, turn the HP All-in-One off and then on again.

Troubleshooting

•
•
•

•

If you are connecting the HP All-in-One through a USB hub, make sure the hub is
turned on. If the hub is on, try connecting directly to your computer.
Check other printers or scanners. You might need to disconnect older products from
your computer.
Try connecting the USB cable to another USB port on your computer. After you check
the connections, try restarting your computer. Turn the HP All-in-One off and then on
again.
If necessary, remove the software you installed with the HP All-in-One and then install
it again.

For more information, see:
•
•

Uninstall and reinstall the software
Find more information

Information on paper
The HP All-in-One is designed to work well with most paper types. Test a variety of paper
types before buying a large quantity. Find a paper type that works well and is easy to
purchase. HP Premium papers are designed for the best quality results. In addition, follow
these tips:
•
•

•
•
•
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Do not use paper that is too thin, that has a slick texture, or that stretches easily. It
can feed incorrectly through the paper path, causing paper jams.
Store photo media in its original packaging inside a resealable plastic bag on a flat
surface in a cool, dry place. When you are ready to print, remove only the paper you
plan to use immediately. When you have finished printing, return any unused photo
paper to the plastic bag.
Do not leave unused photo paper in the input tray. The paper might start to curl, which
might reduce the quality of your printouts. Curled paper can also cause paper jams.
Always hold photo paper by the edges. Fingerprints on photo paper can reduce print
quality.
Do not use paper that is heavily textured. It can cause graphics or text to print
improperly.

Troubleshooting

•
•

Do not combine different paper types and paper sizes in the input tray; the entire stack
of paper in the input tray must be the same size and type.
Store printed photos under glass or in a storage book to prevent bleeding over time
from high humidity. Use HP Premium Plus photo paper for maximum performance.

If the HP All-in-One has a paper jam, check the rear door.

To clear a paper jam from the rear door
1. Press in the tab on the left side of the rear door to release the door. Remove the door
by pulling it away from the HP All-in-One.

2. Gently pull the paper out of the rollers.
CAUTION: If the paper tears when you are removing it from the rollers, check
the rollers and wheels for torn pieces of paper that might be remaining inside the
device. If you do not remove all the pieces of paper from the HP All-in-One, more
paper jams are likely to occur.
3. Replace the rear door. Gently push the door forward until it snaps into place.
4. Press Resume to continue the current job.

View the Readme file
You might want to refer to the Readme file for information on system requirements and
possible installation problems.
You can access the Readme file by clicking Start, pointing to Programs or All
Programs, pointing to HP, pointing to 915 All-In-One, and then clicking Readme.

Hardware setup troubleshooting
This section contains hardware troubleshooting information for the HP All-in-One.
Many issues are caused when the HP All-in-One is connected to the computer using a
USB cable before the HP All-in-One software is installed on the computer. If you
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connected the HP All-in-One to your computer before the software installation screen
prompts you to do so, you must follow these steps:

Troubleshooting

Troubleshooting common setup issues
1. Disconnect the USB cable from the computer.
2. Uninstall the software (if you have already installed it).
3. Restart your computer.
4. Turn off the HP All-in-One, wait one minute, then restart it.
5. Reinstall the HP All-in-One software.
CAUTION: Do not connect the USB cable to the computer until prompted by the
software installation screen.
This section contains the following topics:
•
•
•

The HP All-in-One will not turn on
I connected the USB cable, but I am having problems using the HP All-in-One with
my computer
The HP All-in-One does not print

The HP All-in-One will not turn on
Cause:

The HP All-in-One is not properly connected to a power supply.

Solution:
• Make sure the power cord is firmly connected to both the HP All-in-One and the
power adapter. Plug the power cord into a grounded power outlet, surge protector,
or power strip.
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1

Power connection

2

Power cord and adapter

3

Grounded power outlet
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•

•

If you are using a power strip, make sure the power strip is on. Or, try plugging
the HP All-in-One directly into a grounded power outlet.
Test the power outlet to make sure it is working. Plug in an appliance that you
know works, and see if the appliance has power. If not, then there might be a
problem with the power outlet.
If you plugged the HP All-in-One into a switched outlet, make sure the switch is
on. If it is switched to on but still does not work, then there might be a problem
with the power outlet.

Cause: You pressed the On button too quickly.
Solution: The HP All-in-One might not respond if you press the On button too
quickly. Press the On button once. It might take a few minutes for the HP All-in-One
to turn on. If you press the On button again during this time, you might turn the device
off.
CAUTION: If the HP All-in-One still does not turn on, it might have a mechanical
failure. Unplug the HP All-in-One from the power outlet and contact HP. Go to:
www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

I connected the USB cable, but I am having problems using the HP All-in-One with
my computer
Cause: The USB cable was connected before the software was installed.
Connecting the USB cable before prompted can cause errors.
Solution: You must first install the software that came with the HP All-in-One before
connecting the USB cable. During installation, do not plug in the USB cable until
prompted by the onscreen instructions.
Once you have installed the software, connecting your computer to the HP All-in-One
with a USB cable is straightforward. Simply plug one end of the USB cable into the
back of your computer and the other into the back of the HP All-in-One. You can
connect to any USB port on the back of your computer.
If you installed the software, uninstall it and then reinstall it, connecting the USB cable
only when prompted.
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For more information on installing the software and connecting the USB cable, see
the Setup Guide that came with the HP All-in-One.

The HP All-in-One does not print
Cause:

The HP All-in-One and computer are not communicating with each other.

Troubleshooting

Solution:
• Look at the On light located on the front of the HP All-in-One. If it is not lit, the
HP All-in-One is turned off. Make sure the power cord is firmly connected to the
HP All-in-One and plugged into a power outlet. Press the On button to turn on the
HP All-in-One.
• Make sure the print cartridges are installed.
• Make sure you have paper loaded in the input tray.
• Check that the HP All-in-One does not have a paper jam.
• Check that the print carriage is not jammed.
Open the print cartridge door to access the print carriage area. Remove any
objects that are blocking the print carriage, including any packing materials. Turn
the HP All-in-One off and then turn it on again.
• Check that the HP All-in-One print queue is not paused. If it is, choose the
appropriate setting to resume printing. For more information about accessing the
print queue, see the documentation that came with the operating system installed
on your computer.
• Check the USB cable. If you are using an older cable, it might not be working
properly. Try connecting it to another product to see if the USB cable works. If
you experience problems, the USB cable might need to be replaced. Also verify
that the cable does not exceed 3 meters (9.8 feet) in length.
• Make sure your computer is USB ready and that you are using a supported
operating system. For more information, see the Readme file.
• Check the connection from the HP All-in-One to your computer. Verify that the
USB cable is securely plugged into the USB port on the back of the HP All-inOne. Make sure the other end of the USB cable is plugged into a USB port on
your computer. After the cable is connected properly, turn the HP All-in-One off
and then on again.
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If you are connecting the HP All-in-One through a USB hub, make sure the hub
is turned on. If the hub is on, try connecting directly to your computer.
Check other printers or scanners. You might need to disconnect older products
from your computer.
Try connecting the USB cable to another USB port on your computer. After you
check the connections, try restarting your computer. Turn the HP All-in-One off
and then on again.
After you check the connections, try restarting your computer. Turn the HP All-inOne off and then on again.
If necessary, remove and then install the software you installed with the HP Allin-One again. For more information, see Uninstall and reinstall the software.

For more information on setting up the HP All-in-One and connecting it to your
computer, see the Setup Guide that came with the HP All-in-One.

Software installation troubleshooting
Use this section to solve any problems you might encounter while setting up the HP Allin-One software.
This section contains the following topics:
•
•
•
•
•
•
•
•
•

When I insert the CD-ROM into my computer’s CD-ROM drive, nothing happens
The minimum system checks screen appears
A red X appears on the USB connect prompt
I received a message that an unknown error has occurred
Some of the buttons are missing in the HP Solution Center
The registration screen does not appear
The HP Digital Imaging Monitor does not appear in the system tray
Missing HP Photosmart Software
Uninstall and reinstall the software

When I insert the CD-ROM into my computer’s CD-ROM drive, nothing happens
Cause: The installation failed to run automatically.
Solution:

If the installation does not run automatically, you can start it manually.

To start the installation from a Windows computer
1. From the Windows Start menu, click Run.
2. In the Run dialog box, enter d:\setup.exe, and then click OK.
If your CD-ROM drive is not assigned to drive letter D, enter the appropriate drive
letter.

The minimum system checks screen appears
Cause: Your system does not meet the minimum requirements to install the
software.
Software installation troubleshooting

83

Troubleshooting

•

Chapter 12

Solution: Click Details to see what the specific problem is, and then correct the
problem before attempting to install the software.

A red X appears on the USB connect prompt
Troubleshooting

Cause: Normally, a green check appears indicating that the plug and play is
successful. A red X indicates that the plug and play failed.
Solution:
To retry the plug and play
1. Verify that the control panel overlay is firmly attached, unplug the HP All-in-One
power cord, and then plug it in again.
2. Verify that the USB cable and power cord are plugged in.

3. Click Retry to retry the plug and play setup. If this does not work, continue to the
next step.
4. Verify that the USB cable is set up properly as follows:
• Unplug the USB cable and plug it in again.
• Do not attach the USB cable to a keyboard or non-powered hub.
• Verify that the USB cable is 3 meters (9.8 feet) or less in length.
• If you have several USB devices attached to your computer, you might want
to unplug the other devices during the installation.
5. Continue with the installation and restart the computer when prompted.
6. If you are using a Windows computer, open the HP Solution Center and check
for the appropriate buttons for your device (such as Make Copies). If the buttons
do not appear, remove the software and then reinstall it.
For more information, see:
Uninstall and reinstall the software

I received a message that an unknown error has occurred
Cause:
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The source of the error is unknown.

Solution: Try to continue with the installation. If that does not work, stop and then
restart the installation, and follow the directions on the screen. If an error occurs, you
might need to uninstall and then reinstall the software. Do not simply delete the HP Allin-One application files from your computer. Make sure to remove them properly using
the uninstall utility provided when you installed the software that came with the HP Allin-One.
Troubleshooting

For more information, see:
Uninstall and reinstall the software

Some of the buttons are missing in the HP Solution Center
Cause: The installation might not be complete.
Solution: If the appropriate buttons for your device (such as Make Copies) do not
appear, your installation might not be complete, and you might need to uninstall and
then reinstall the software. Do not simply delete the HP All-in-One application files
from your hard drive. Make sure to remove them properly using the uninstall utility
provided in the HP All-in-One program group.
For more information, see:
Uninstall and reinstall the software

The registration screen does not appear
Cause: The registration screen did not launch automatically.
Solution: You can access the registration (Sign up now) screen from the Windows
taskbar by clicking Start, pointing to Programs or All Programs, HP, 915 All-InOne, and then clicking Product Registration.

The HP Digital Imaging Monitor does not appear in the system tray
Cause: The installation might not be complete.
Solution: If the HP Digital Imaging Monitor does not appear in the system tray
(normally located at the lower-right corner of the desktop), start the HP Solution
Center.
If the appropriate buttons for your device (such as Make Copies) do not appear, your
installation might not be complete, and you might need to uninstall and then reinstall
the software. Do not simply delete the HP All-in-One application files from your hard
drive. Make sure to remove them properly using the uninstall utility provided in the
HP All-in-One program group.
For more information, see:
Uninstall and reinstall the software

Missing HP Photosmart Software
Cause: The HP Photosmart Software is not installed.
Software installation troubleshooting

85

Chapter 12

Solution: Install the HP Photosmart Software that came with the HP All-in-One. If
it is installed, restart your computer.

Troubleshooting

To install the HP Photosmart Software
1. Insert the HP All-in-One CD-ROM into your computer’s CD-ROM drive and then
start the Setup program.
2. When prompted, click Install More Software to install the HP Photosmart
Software.
3. Follow the onscreen instructions and the instructions provided in the Setup Guide
that came with the HP All-in-One.
Cause:

The HP All-in-One is turned off.

Solution:
Cause:

The computer is turned off.

Solution:
Cause:

Turn the HP All-in-One on.

Turn the computer on.

The HP All-in-One is not properly connected to the computer.

Solution: Check the connection from the HP All-in-One to your computer. Verify
that the USB cable is securely plugged into the USB port on the back of the HP Allin-One. Make sure the other end of the USB cable is plugged into a USB port on your
computer. After the cable is connected properly, turn the HP All-in-One off and then
on again.

For more information on setting up the HP All-in-One and connecting it to your
computer, see the Setup Guide that came with the HP All-in-One.

Uninstall and reinstall the software
If your installation is incomplete, or if you connected the USB cable to the computer before
prompted by the software installation screen, you might need to uninstall and then
reinstall the software. Do not simply delete the HP All-in-One application files from your
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To uninstall from a Windows computer, method 1
1. Disconnect the HP All-in-One from your computer. Do not connect the HP All-in-One
to your computer until after you have reinstalled the software.
2. On the Windows taskbar, click Start, Programs or All Programs, HP, 915 All-InOne, Uninstall.
3. Follow the onscreen instructions.
4. If you are asked whether you would like to remove shared files, click No.
Other programs that use these files might not work properly if the files are deleted.
5. Restart your computer.
NOTE: It is important that you disconnect the HP All-in-One before restarting
your computer. Do not connect the HP All-in-One to your computer until after you
have reinstalled the software.
6. To reinstall the software, insert the HP All-in-One CD-ROM into your computer’s CDROM drive, and follow the onscreen instructions and the instructions provided in the
Setup Guide that came with the HP All-in-One.
7. After the software is installed, connect the HP All-in-One to your computer.
8. Press the On button to turn the HP All-in-One on.
After connecting and turning on the HP All-in-One, you might have to wait several
minutes for all of the Plug and Play events to complete.
9. Follow the onscreen instructions.
To uninstall from a Windows computer, method 2
NOTE: Use this method if Uninstall is not available in the Windows Start menu.
1. On the Windows taskbar, click Start, Settings, Control Panel.
2. Double-click Add/Remove Programs.
3. Select HP Deskjet All-In-One Driver Software, and then click Change/Remove.
Follow the onscreen instructions.
4. Disconnect the HP All-in-One from your computer.
5. Restart your computer.
NOTE: It is important that you disconnect the HP All-in-One before restarting
your computer. Do not connect the HP All-in-One to your computer until after you
have reinstalled the software.
6. Insert the HP All-in-One CD-ROM into your computer’s CD-ROM drive and then start
the Setup program.
7. Follow the onscreen instructions and the instructions provided in the Setup Guide that
came with the HP All-in-One.
To uninstall from a Windows computer, method 3
NOTE: Use this method if Uninstall is not available in the Windows Start menu.

Software installation troubleshooting
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computer. Make sure to remove them properly using the uninstall utility provided when
you installed the software that came with the HP All-in-One.
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1. Insert the HP All-in-One CD-ROM into your computer’s CD-ROM drive and then start
the Setup program.
2. Disconnect the HP All-in-One from your computer.
3. Select Uninstall and follow the onscreen directions.
4. Restart your computer.
Troubleshooting

NOTE: It is important that you disconnect the HP All-in-One before restarting
your computer. Do not connect the HP All-in-One to your computer until after you
have reinstalled the software.
5. Start the Setup program for the HP All-in-One again.
6. Select Install.
7. Follow the onscreen instructions and the instructions provided in the Setup Guide that
came with the HP All-in-One.
When the software installation is complete, the HP Digital Imaging Monitor icon appears
in the Windows system tray.
To verify that the software is properly installed, double-click the HP Solution Center icon
on the desktop. If the HP Solution Center shows the essential icons (Scan Picture and
Scan Document), the software has been properly installed.

Print cartridge troubleshooting
If you are experiencing problems with printing, you might have a problem with one of the
print cartridges. If you receive an error message about the print cartridges, see Print
cartridge messages for more information.
Try the following:
To troubleshoot print cartridges
1. Remove the black print cartridge from the slot on the right. Do not touch the ink
nozzles or the copper-colored contacts. Check for possible damage to the coppercolored contacts or ink nozzles.
Make sure the plastic tape has been removed. If it is still covering the ink nozzles,
gently remove the plastic tape by using the pink pull tab.
2. Reinsert the print cartridge by sliding it forward into the slot. Then push the print
cartridge forward until it clicks into the socket.

3. Repeat steps 1 and 2 for the tri-color print cartridge on the left side.
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1

Copper-colored contacts

2

Ink nozzles (do not clean)

7. If you are still experiencing problems with printing, determine which print cartridge is
experiencing the problem and replace it.
To check the ink levels from the HP Photosmart Software
1. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.
NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.
The Printer Toolbox appears.
2. Click the Estimated Ink Level tab.
The estimated ink levels for the print cartridges appear.

Print cartridge troubleshooting
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4. If the problem persists, print a self-test report to determine if there is a problem with
the print cartridges.
This report provides useful information about your print cartridges, including status
information.
5. If the self-test report shows a problem, clean the print cartridges.
6. Clean only the copper-colored contacts. Allow the print cartridges to dry for
approximately ten minutes before reinserting.

Chapter 12

To print a self-test report
1. Load letter or A4 unused plain white paper into the input tray.
2. Press and hold the Cancel button and then press the Start Copy Color button.
The HP All-in-One prints a self-test report, which might indicate the source of the
printing problem. A sample of the ink test area of the report is shown below.
Troubleshooting

3. Make sure the test patterns show a complete grid and the thick color lines are
complete.
• If more than a few lines in a pattern are broken, this might indicate a problem with
the nozzles. You might need to clean the print cartridges.
• If the black line is missing, faded, streaked, or shows lines, this might indicate a
problem with the black print cartridge in the right slot.
• If any of the color lines are missing, faded, streaked, or show lines, this might
indicate a problem with the tri-color print cartridge in the left slot.
To clean the print cartridges from the HP Photosmart Software
1. Load letter, A4, or legal unused plain white paper into the input tray.
2. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.
NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Services tab, and then click
Service this device.
The Printer Toolbox appears.
3. Click the Device Services tab.
4. Click Clean the Print Cartridges.
5. Follow the prompts until you are satisfied with the quality of the output, and then click
Done.
If copy or print quality still seems poor after you clean the print cartridges, try cleaning
the print cartridge contacts before replacing the affected print cartridge.
To clean the print cartridge contacts
1. Turn on the HP All-in-One and open the print cartridge door.
The print carriage moves to the center of the HP All-in-One.
2. Wait until the print carriage is idle and silent, and then unplug the power cord from
the back of the HP All-in-One.
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3. Lightly press down on the print cartridge to release it, and then pull it toward you out
of the slot.

4. Inspect the print cartridge contacts for ink and debris buildup.
5. Dip a clean foam rubber swab or lint-free cloth into distilled water, and squeeze any
excess water from it.
6. Hold the print cartridge by its sides.
7. Clean only the copper-colored contacts. Allow the print cartridges to dry for
approximately ten minutes before reinserting.

1

Copper-colored contacts

2

Ink nozzles (do not clean)

8. Slide the print cartridge back into the slot. Push the print cartridge forward until it clicks
into place.
9. Repeat if necessary for the other print cartridge.
10. Gently close the print cartridge door and plug the power cord into the back of the
HP All-in-One.

Print cartridge troubleshooting

91

Troubleshooting

NOTE: Do not remove both print cartridges at the same time. Remove and clean
each print cartridge one at a time. Do not leave a print cartridge outside the HP Allin-One for more than 30 minutes.
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To replace the print cartridges
1. Make sure the HP All-in-One is on.
CAUTION: If the HP All-in-One is off when you open the print cartridge door to
access the print cartridges, the HP All-in-One will not release the cartridges for
changing. You might damage the HP All-in-One if the print cartridges are not
docked safely when you try to remove them.
Troubleshooting

2. Open the print cartridge door.
The print carriage should move to the center of the HP All-in-One. If the print carriage
does not move to the center, turn the HP All-in-One off, and then on.

3. Wait until the print carriage is idle and silent, and then lightly press down on a print
cartridge to release it.
If you are replacing the tri-color print cartridge, remove the print cartridge from the
slot on the left.
If you are replacing the black or photo print cartridge, remove the print cartridge from
the slot on the right.

1

Print cartridge slot for the tri-color print cartridge

2

Print cartridge slot for the black and photo print cartridges

4. Pull the print cartridge toward you out of its slot.
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1

Copper-colored contacts

2

Plastic tape with pink pull tab (must be removed before installing)

3

Ink nozzles under tape

CAUTION: Do not touch the copper-colored contacts or ink nozzles. Touching
these parts can result in clogs, ink failure, and bad electrical connections.

7. Slide the new print cartridge forward into the empty slot. Then gently push on the
upper part of the print cartridge forward until it clicks into the socket.
If you are installing the tri-color print cartridge, slide it into the left slot.

Print cartridge troubleshooting
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5. If you are removing the black print cartridge in order to install the photo print cartridge,
store the black print cartridge in the print cartridge protector or an airtight plastic
container.
If you are removing the print cartridge because it is low or out of ink, recycle the print
cartridge. The HP Inkjet Supplies Recycling Program is available in many countries/
regions, and lets you recycle used print cartridges free of charge. For more
information, go to the following Web site:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/inkjet.html
6. Remove the new print cartridge from its packaging, being careful to touch only the
black plastic. Gently remove the pastic tape using the pink pull tab.
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If you are installing a black or photo print cartridge, slide it into the right slot.

Troubleshooting

8. Close the print cartridge door.

9. If the print cartridge alignment sheet prints, load it on the left front corner of the glass
with the top of the page to the left.

10. Press the Scan button.
The HP All-in-One aligns the print cartridges. Recycle or discard the print cartridge
alignment sheet.

Information on print cartridges
For best results, use HP print cartridges. The following tips help maintain HP print
cartridges and ensure consistent print quality.
•
•

94

Keep all print cartridges in the original sealed packages until they are needed.
Store print cartridges at room temperature (15.6°-26.6° C or 60°-78° F).
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•
•

•

Do not reattach the protective tape once it has been removed from the print cartridge.
Reattaching the plastic tape might damage the print cartridge. Place the print cartridge
in the HP All-in-One immediately after removing the plastic tape. If this is not possible,
store it in a print cartridge protector or airtight plastic container.
HP recommends that you do not remove the print cartridges from the HP All-in-One
until you have replacement print cartridges available to install.
Turn off the HP All-in-One from the control panel. Do not turn off the device by turning
off a power strip or unplugging the power cord from the HP All-in-One. If you
improperly turn off the HP All-in-One, the print carriage does not return to the correct
position and the print cartridges can dry out.
Do not open the print cartridge door unless necessary. This exposes the print
cartridges to air, which reduces the life of the print cartridges.
NOTE: If you leave the print cartridge door open for a long period of time, the
HP All-in-One will recap the print cartridges to protect them from exposure to air.

•

Clean the print cartridges when you notice a significant decrease in print quality.
TIP: You might notice a decrease in print quality if the print cartridges have not
been used for a long time.

•
•

Do not clean the print cartridges unnecessarily. This wastes ink and shortens the life
of the cartridges.
Handle print cartridges carefully. Dropping, jarring, or rough handling during
installation can cause temporary printing problems. If print quality is poor right after
cartridge installation, allow half an hour for the print cartridge to recover.

For more information, see:
Print cartridge troubleshooting

Print quality troubleshooting
If you are having problems with print quality, try the solutions in this section and observe
the following guidelines:
•
•

•

Replace refilled or empty cartridges.
Check the device settings to make sure that the print mode and paper selection is
correct for the paper and the task.
For more information, see Set the paper type for printing and Choose papers for
printing and copying.
Print and evaluate a self-test.
For more information, see Print a self-test report.

Print quality troubleshooting
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•
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•

If the self-test shows a defect, try the following:
• Clean the print cartridges automatically. For more information, see Clean the print
cartridges.
• If you are missing lines when you print, clean the electrical contacts. For more
information, see Clean the area around the ink nozzles.
• Replace the print cartridge. For more information, see Replace the print
cartridges.
If the self-test does not show a problem, investigate other causes, such as the image
file or software program.

For additional print cartridge troubleshooting, visit the HP Web site at www.hp.com/
support.
This section contains the following topics:
•
•
•
•
•
•
•
•

Ink is bleeding or smearing
Ink is not filling the text or graphics completely
The text edges are jagged
The printout has a horizontal band of distortion near the bottom of the page
Printouts or copies seem blurry or fuzzy
Printouts or copies have vertical streaks
Paper is not picked up from the input tray
Printouts or copies are slanted or skewed

Ink is bleeding or smearing
Cause:

The paper type is not suitable for the HP All-in-One.

Solution: Use HP Premium Papers or any other paper type that is appropriate for
the HP All-in-One.
Cause:

The print cartridges need to be cleaned.

Solution: Check the estimated ink levels remaining in the print cartridges. If the
print cartridges are low or out of ink, you might need to replace the print cartridges.
If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.
For more information, see:
•
•

Print cartridge troubleshooting
Print a self-test report

Cause:

The paper is too close to the print cartridge during printing.

Solution: If the paper is too close to the print cartridge during printing, the ink might
be smeared. This can happen if the paper is raised, wrinkled, or very thick, such as
a mailing envelope. Make sure the paper lays flat in the input tray and is not too
wrinkled.
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Ink is not filling the text or graphics completely
Cause: The print cartridges need to be cleaned or might be out of ink.

If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.
For more information on print cartridges, see Print cartridge troubleshooting.
Cause: The copy or print paper type setting is incorrect.
Solution: Change the paper type setting to match the type of paper loaded in the
input tray.
For more information, see:
•
•

Set the paper type for printing
Set the copy paper type

Cause: The print quality or copy setting on the HP All-in-One is set too low.
Solution: Check the quality setting. Use a higher quality setting to increase the
amount of ink used for printing.
For more information, see:
•
•

Change the print speed or quality
Change copy speed

The text edges are jagged
Cause: The font is a custom size.
Solution: Some software applications offer custom fonts that have jagged edges
when enlarged or printed. Also, if you want to print bitmapped text, it might have
jagged edges when enlarged or printed.
Use TrueType or OpenType fonts to ensure that the HP All-in-One is able to print
smooth fonts. When selecting a font, look for the TrueType or OpenType icon.

The printout has a horizontal band of distortion near the bottom of the page
Cause: Your photo image has light blue, gray, or brown hues that print near the
bottom of the page.
Solution: Load high-quality paper in the input tray and print the image with a high
print quality setting, such as Best, Maximum dpi, or High Resolution. Always make
sure the paper you are printing on is flat. For best results when printing images, use
HP Premium Plus Photo Paper.

Print quality troubleshooting
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Solution: Check the estimated ink levels remaining in the print cartridges. If the
print cartridges are low or out of ink, you might need to replace the print cartridges.
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If the problem persists, use the software you installed with the HP All-in-One or
another software application to rotate your image 180 degrees so that the light blue,
gray, or brown hues in your image do not print at the bottom of the page. Print the
image using six-ink printing. To do so, install the photo print cartridge in place of the
black print cartridge. With the photo print cartridge and the tri-color print cartridge
installed, you have a six-ink system, which provides enhanced quality photos.
Troubleshooting

For more information, see:
•
•

Information on paper
Print cartridge troubleshooting

Printouts or copies seem blurry or fuzzy
Cause:

The paper type is not suitable for the HP All-in-One.

Solution: If the paper you are using is too fibrous, the ink applied by the HP All-inOne might not fully cover the surface of the paper. Use HP Premium Papers or any
other paper type that is appropriate for the HP All-in-One.
For more information, see:
Information on paper
Cause:

The copy or print paper type setting is incorrect.

Solution: Change the paper type setting to match the type of paper loaded in the
input tray.
For more information, see:
•
•

Set the paper type for printing
Set the copy paper type

Cause:

The print quality or copy setting on the HP All-in-One is set too low.

Solution: Check the quality setting. Use a higher quality setting to increase the
amount of ink used for printing.
For more information, see:
•
•

Change the print speed or quality
Change copy speed

Cause:

You are printing on the wrong side of the paper.

Solution: Load paper with the side you want to print on facing down. For example,
if you are loading glossy photo paper, load the paper with the glossy side down.

Printouts or copies have vertical streaks
Cause:
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The paper type is not suitable for the HP All-in-One.

Solution: If the paper you are using is too fibrous, the ink applied by the HP All-inOne might not fully cover the surface of the paper. Use HP Premium Papers or any
other paper type that is appropriate for the HP All-in-One.
For more information, see:

Paper is not picked up from the input tray
Cause: There is not enough paper in the input tray.
Solution: If the HP All-in-One is out of paper or there are only a few sheets
remaining, load more paper in the input tray. If there is paper in the input tray, remove
the paper, tap the stack of paper against a flat surface, and reload the paper into the
input tray. To continue your print job, press the Resume button on the control panel
of the HP All-in-One.
For more information, see:
Load full-size paper

Printouts or copies are slanted or skewed
Cause: The paper is not feeding properly or is loaded incorrectly.
Solution:

Make sure the paper is loaded correctly.

For more information, see:
Load full-size paper
Cause: More than one type of paper is loaded in the input tray.
Solution:

Load only one type of paper at a time.

Print troubleshooting
Use this section to solve these printing problems:
•
•
•
•
•
•
•
•
•
•

Envelopes print incorrectly
Borderless printing produces unexpected results
The HP All-in-One is not responding
The HP All-in-One prints meaningless characters
Nothing happens when I try to print
The pages in my document came out in the wrong order
The margins are not printing as expected
Text or graphics are cut off at the edge of the page
A blank page came out while printing
Ink is spraying the inside of the HP All-in-One when I print a photo

Print troubleshooting
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Envelopes print incorrectly
Cause:

A stack of envelopes is loaded incorrectly.

Solution: Remove all paper from the input tray. Load a stack of envelopes in the
input tray, with the envelope flaps facing up and on the left.
NOTE: To avoid paper jams, tuck the flaps inside the envelopes.
Troubleshooting

Cause:

The wrong type of envelope is loaded.

Solution: Do not use shiny or embossed envelopes or envelopes that have clasps
or windows.

Borderless printing produces unexpected results
Cause: Printing a borderless image from a non-HP software application produces
unexpected results.
Solution: Try printing the image from the photo imaging software that came with
the HP All-in-One.
Cause:

Use of inappropriate media.

Solution: To print a borderless image, use 10 x 15 cm (4 x 6 inch) HP Premium
Plus Photo Papers with a tear-off tab. When you remove the tear-off tab, the printed
image is borderless and extends to the edges of the paper.
For more information, see:
Print a borderless image

The HP All-in-One is not responding
Cause:

The HP All-in-One is busy with another task.

Solution: If the HP All-in-One is performing another task such as copying or
scanning, your print job will be delayed until the HP All-in-One completes the current
task.
Some documents take a long time to print. If nothing has printed several minutes after
you sent a print job to the HP All-in-One, check your computer to see if there are any
messages.
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Cause: The HP All-in-One has a paper jam.
Solution:

Clear the paper jam.

For more information, see:
Clear paper jams

Solution:

Troubleshooting

Cause: The HP All-in-One is out of paper.
Load paper in the input tray.

For more information, see:
Load full-size paper
Cause: The print carriage has stalled.
Solution: Turn the HP All-in-One off, remove any objects that are blocking the print
carriage (including any packing materials), and then turn the HP All-in-One on again.

Cause: The computer is not communicating with the HP All-in-One.
Solution: If the HP All-in-One is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is connected to the HP Allin-One and the computer as shown below.

Print troubleshooting
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If the connections are secure, and nothing has printed several minutes after you sent
a print job to the HP All-in-One, check the status of the HP All-in-One. In the
HP Photosmart Software, click Status.
For more information, see:
Communication problems over a USB connection
Troubleshooting

Cause:

The HP All-in-One is turned off.

Solution: Look at the On light located on the front of the HP All-in-One. If it is not
lit, the HP All-in-One is turned off. Make sure the power cord is firmly connected to
the HP All-in-One and plugged into a power outlet. Press the On button to turn on the
HP All-in-One.
Cause:

The HP All-in-One experienced an error.

Solution: Turn the HP All-in-One off, and then unplug the power cord. Plug the
power cord back in, and then press the On button to turn on the HP All-in-One.
Cause:

The status of the printer driver has changed.

Solution:
printing.

The printer driver status might have changed to either offline or stop

To check the printer driver status
1. In the HP Solution Center, click the device tab.
2. Click Settings.
3. Click Status.
If the status is offline or stop printing, change the status to ready.
Cause:

A deleted print job is still in the queue.

Solution: A print job might remain in the queue after it has been cancelled. The
cancelled print job jams the queue and prevents the next print job from printing.
From your computer, open the printer folder and see if the cancelled job remains in
the print queue. Try to delete the job from the queue. If the print job remains in the
queue, try one or both of the following:
•
•

Disconnect the USB cable from the HP All-in-One, restart the computer, and then
reconnect the USB cable to the HP All-in-One.
Shut down the HP All-in-One, restart the computer, and then restart the HP Allin-One.

The HP All-in-One prints meaningless characters
Cause:

The memory in the HP All-in-One is full.

Solution: Turn off the HP All-in-One and your computer for 60 seconds, then turn
them both on and try printing again.
Cause:
102

Troubleshooting

The document is corrupt.

Solution: Try printing another document from the same software application. If this
works, then try printing a previously saved version of the document that is not corrupt.

Nothing happens when I try to print
Solution: Look at the On light located on the front of the HP All-in-One. If it is not
lit, the HP All-in-One is turned off. Make sure the power cord is firmly connected to
the HP All-in-One and plugged into a power outlet. Press the On button to turn on the
HP All-in-One.
Cause: The HP All-in-One is busy with another task.
Solution: If the HP All-in-One is performing another task such as copying or
scanning, your print job will be delayed until the HP All-in-One completes the current
task.
Some documents take a long time to print. If nothing has printed several minutes after
you sent a print job to the HP All-in-One, check your computer to see if there are any
messages.
Cause: The HP All-in-One is not the selected printer.
Solution: Make sure the HP All-in-One is the selected printer in your software
application.
TIP: You can set the HP All-in-One as the default printer to ensure that the printer
is automatically selected when you select Print in the File menu of your different
software applications. For more information, see Make the HP All-in-One the
default printer.
Cause: The computer is not communicating with the HP All-in-One.
Solution: If the HP All-in-One is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is connected to the HP Allin-One and the computer as shown below.
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Cause: The HP All-in-One is turned off.
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If the connections are secure, and nothing has printed several minutes after you sent
a print job to the HP All-in-One, check the status of the HP All-in-One. In the
HP Photosmart Software, click Status.
For more information, see:
Communication problems over a USB connection
Troubleshooting

Cause:

The HP All-in-One has a paper jam.

Solution:

Clear the paper jam.

For more information, see:
Clear paper jams
Cause:

The print carriage has stalled.

Solution: Turn the HP All-in-One off, remove any objects that are blocking the print
carriage (including any packing materials), and then turn the HP All-in-One on again.

Cause:

The HP All-in-One is out of paper.

Solution:

Load paper in the input tray.

For more information, see:
Load full-size paper

The pages in my document came out in the wrong order
Cause: The print settings are set to print the first page of your document first.
Because of the way the paper feeds through the HP All-in-One, this means the first
page will be print side up at the bottom of the stack.
Solution: Print the document in reverse order. When the document finishes
printing, the pages will be in correct order.
For more information, see:
Print a multiple-page document in reverse order

The margins are not printing as expected
Cause:
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The margins are not set correctly in your software application.

Solution:

Check the printer margins.

To check your margin settings
1. Preview your print job before sending it to the HP All-in-One.
2. Check the margins.
The HP All-in-One uses the margins you have set in your software application,
as long as they are greater than the minimum margins the HP All-in-One supports.
3. Cancel the print job if the margins are not satisfactory, and then adjust the margins
in your software application.
Cause: The paper size setting might not be set correctly for the project you are
printing.
Solution: Verify that you have selected the proper paper size setting for your
project. Make sure that you have loaded the correct paper size in the input tray.
For example, in some countries/regions you may need to specify A4 as the paper
size if A (letter) is the default value.
For more information, see:
Set the paper type for printing
Cause: The paper guides are not positioned correctly.
Solution: Remove the stack of paper from the input tray, and then reload the paper.
Make sure that you slide the paper-width guide inward until it stops at the edge of the
paper.
For more information, see:
Load paper
Cause: A stack of envelopes is loaded incorrectly.
Solution: Remove all paper from the input tray. Load a stack of envelopes in the
input tray, with the envelope flaps facing up and on the left.
NOTE: To avoid paper jams, tuck the flaps inside the envelopes.
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Make sure the margin settings for the document do not exceed the printable area of
the HP All-in-One.
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For more information, see:
Load envelopes

Text or graphics are cut off at the edge of the page
Troubleshooting

Cause:

The margins are not set correctly in your software application.

Solution: Make sure the margin settings for the document do not exceed the
printable area of the HP All-in-One.
To check your margin settings
1. Preview your print job before sending it to the HP All-in-One.
2. Check the margins.
The HP All-in-One uses the margins you have set in your software application,
as long as they are greater than the minimum margins the HP All-in-One supports.
3. Cancel the print job if the margins are not satisfactory, and then adjust the margins
in your software application.
Cause: The size of the document you are printing is larger than the paper loaded
in the input tray.
Solution: Make sure the layout of the document you are trying to print fits on a paper
size supported by the HP All-in-One.
To preview the print layout
1. Load the correct paper size into the input tray.
2. Preview your print job before sending it to the HP All-in-One.
3. Check the graphics in the document to make sure that the current size fits within
the printable area of the HP All-in-One.
4. Cancel the print job if the graphics do not fit in the printable area of the page.
TIP: Some software applications allow you to scale the document to fit the paper
size currently selected. Additionally, you can scale the size of a document from
the print Properties dialog box.
Cause:

The paper is loaded incorrectly.

Solution:

If the paper is misfeeding, it could cause parts of the document to cut off.

Remove the stack of paper from the input tray, and then reload the paper. Make sure
that you slide the paper-width guide inward until it stops at the edge of the paper.
For more information, see:
Load full-size paper

A blank page came out while printing
Cause: If you are printing black text, and a blank page comes out of the HP All-inOne, the black print cartridge might be empty.
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Solution: Check the estimated ink levels remaining in the print cartridges. If the
print cartridges are low or out of ink, you might need to replace the print cartridges.

For more information on print cartridges, see Print cartridge troubleshooting.
Cause: The document you are printing contains an additional blank page.
Solution: Open the document file in your software application and remove any extra
pages or lines at the end of the document.
Cause: The HP All-in-One picked up two sheets of paper.
Solution: If the HP All-in-One has only a few sheets remaining, load more paper in
the input tray. If there is plenty of paper in the input tray, remove the paper, tap the
stack of paper against a flat surface, and reload the paper into the input tray.
For more information, see:
Load full-size paper
Cause: The protective plastic tape was only partially removed from the print
cartridge.
Solution: Check each print cartridge. The tape might have been removed from the
copper-colored contacts, but still might cover the ink nozzles. If the tape is still
covering the ink nozzles, carefully remove the tape from the print cartridges. Do not
touch the ink nozzles or the copper-colored contacts.

1

Copper-colored contacts

2

Plastic tape with pink pull tab (must be removed before installing)

3

Ink nozzles under tape

Print troubleshooting
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If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.
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For more information, see:
Replace the print cartridges

Ink is spraying the inside of the HP All-in-One when I print a photo
Troubleshooting

Cause: The borderless print settings require photo paper to be loaded in the input
tray. You are using the wrong paper type.
Solution: Make sure you load photo paper in the input tray before you print a
borderless print job.

Copy troubleshooting
Use this section to solve these copy problems:
•
•
•
•
•

Nothing happens when I try to copy
Parts of the original do not appear or are cut off
The printout appears enlarged on the page
The printout is blank
A borderless copy has white space around the edges

Nothing happens when I try to copy
Cause:

The HP All-in-One is turned off.

Solution: Look at the On light located on the front of the HP All-in-One. If it is not
lit, the HP All-in-One is turned off. Make sure the power cord is firmly connected to
the HP All-in-One and plugged into a power outlet. Press the On button to turn on the
HP All-in-One.
Cause:

The original is placed incorrectly on the glass.

Solution: Place your original with the side you want to copy or scan face down on
the left front corner of the glass.

Cause:
108

Troubleshooting

The HP All-in-One might be busy copying or printing.

Solution:

Check the On light. If it is blinking, the HP All-in-One is busy.

Cause: The HP All-in-One does not recognize the paper type.

Troubleshooting

Solution: Do not use the HP All-in-One to copy onto envelopes or other papers the
HP All-in-One does not support.
Cause: The HP All-in-One has a paper jam.
Solution:

Clear the paper jam.

For more information, see:
Clear paper jams

Parts of the original do not appear or are cut off
Cause: The original is placed incorrectly on the glass.
Solution: Place your original with the side you want to copy or scan face down on
the left front corner of the glass.

Cause: The scanner glass is dirty, causing the device to include an area in the copy
that is larger than the document.
Solution: Clean the scanner glass and make sure that there are no foreign
materials adhering to it.
For more information, see: Clean the glass

The printout appears enlarged on the page
Cause: The copied image does not cover the whole page.
Solution: Ensure that your Copy settings are chosen correctly. If the problem
persists, debris might be stuck on the glass or on the back of the document lid. This
can cause the HP All-in-One to detect only a portion of the image. Turn off the device,

Copy troubleshooting

109

Chapter 12

unplug the power cord, and use a soft cloth to wipe the glass and the back of the
document lid.
For more information, see:
•
•

Clean the lid backing
Clean the glass

Troubleshooting

The printout is blank
Cause:

The original is placed incorrectly on the glass.

Solution:

Cause:

Place your original print side down on the left front corner of the glass.

The print cartridges need to be cleaned or might be out of ink.

Solution: Check the estimated ink levels remaining in the print cartridges. If the
print cartridges are low or out of ink, you might need to replace the print cartridges.
If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.
For more information on print cartridges, see Print cartridge troubleshooting.

A borderless copy has white space around the edges
Cause:

You are trying to make a borderless copy of a very small original.

Solution: When you make a borderless copy of a very small original, the HP All-inOne enlarges the original up to a maximum percentage. This might leave white space
around the edges. (The maximum percentage varies by model.)
Depending on the size of the borderless copy you are trying to make, the minimum
size of the original varies. For example, you cannot enlarge a passport photo to create
a letter-size borderless copy.
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If you want to make a borderless copy of a very small original, scan the original into
the computer, resize the image, and then print a borderless copy of the enlarged
image.
Cause: You are trying to make a borderless copy without using photo paper.
Use photo paper to make borderless copies.

Troubleshooting

Solution:

Scan troubleshooting
Use this section to solve these scan problems:
•
•
•
•
•
•
•
•
•

Scan halts
Scan fails
Scan fails because of insufficient computer memory
Scanned image is blank
Scanned image is incorrectly cropped
Scanned image has incorrect page layout
Text format is incorrect
Scanned image shows dotted lines instead of text
Text is incorrect or missing

Scan halts
Cause: The computer system resources might be low.
Solution: Turn off the HP All-in-One and then turn it back on. Turn off the computer
and then turn it back on.
If this does not work, try changing the scan to a lower resolution in the software.

Scan fails
Cause: The computer is not turned on.
Solution:

Turn on your computer.

Cause: Your computer is not connected to the HP All-in-One by a USB cable.
Solution:

Connect your computer to the HP All-in-One with a standard USB cable.

For more information, see the Setup Guide.
Cause: The HP Photosmart Software might not have been installed.
Solution:

Insert the HP All-in-One installation CD and install the software.

For more information, see the Setup Guide.
Cause: The HP Photosmart Software is installed, but is not running.

Scan troubleshooting
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Solution:
again.

Open the software you installed with the HP All-in-One and try scanning

NOTE: To check to see whether the software is running, right-click on the HP
Digital Imaging Monitor icon in the system tray at the far right of the Windows
taskbar. Pick a device in the list, and then click Display Status.
Troubleshooting

Scan fails because of insufficient computer memory
Cause:

Too many applications are running on your computer.

Solution: Close all applications that are not in use. This includes applications that
run in the background, such as screen savers and virus checkers. If you turn off your
virus checker, remember to turn it back on after you finish your scan.
If this problem occurs frequently, or if you encounter memory problems while using
other applications, you might need to add more memory to your computer. See the
user guide that came with your computer for more information.

Scanned image is blank
Cause:

The original is placed incorrectly on the glass.

Solution: Place your original with the side you want to copy or scan face down on
the left front corner of the glass.

Scanned image is incorrectly cropped
Cause:

The software is set to automatically crop scanned pictures.

Solution: The autocropping feature in the software crops anything that is not part
of the main image. Sometimes this might not be what you want. In that case, turn off
autocropping in the software and crop the scanned image manually, or not at all.

Scanned image has incorrect page layout
Cause:
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The automatic cropping feature in the software is changing the page layout.

Solution:

Turn off autocropping in the software to retain the page layout.

Text format is incorrect
Solution: Some applications cannot handle framed text formatting. Framed text is
one of the scan document settings in the software. It maintains complex layouts, such
as multiple columns from a newsletter, by putting the text in different frames (boxes)
in the destination application. In the software, select the correct format so that the
scanned text layout and formatting are retained.

Scanned image shows dotted lines instead of text
Cause: If you use the Text image type to scan text that you plan to edit, the scanner
might not recognize color text. The Text image type scans at 300 x 300 dpi, in black
and white.
If you are scanning an original that has graphics or artwork surrounding the text, the
scanner might not recognize the text.
Solution:

Make a black-and-white copy of the original and then scan the copy.

Text is incorrect or missing
Cause: The brightness is not set correctly.
Solution:

Adjust the brightness in the software, and then rescan the original.

To adjust the brightness
1. In the HP Scanning window, click Lighten/Darken in the Basic menu or the
Tools panel.
2. Adjust the brightness indicators.
Cause: Debris might be stuck on the glass or on the back of the document lid. This
can cause poor-quality scans.
Solution: Turn off the HP All-in-One, unplug the power cord, and use a soft cloth
to wipe the glass and the back of the document lid.
For more information, see:
•
•

Clean the lid backing
Clean the glass

Cause: The scan document settings are not set to the correct optical character
recognition (OCR) language. The OCR language tells the software how to interpret
the characters it sees in the original image. If the OCR language does not match the
language in the original, the scanned text might be incomprehensible.
Solution:

Select the correct OCR language in the software.
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Cause: The scan document settings are incorrect.
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NOTE: If you are using the HP Photosmart Software, the Optical Character
Recognition (OCR) software might not be installed on your computer. To install
the OCR software, you must re-insert the software disk and select OCR under the
Custom installation options.
See the documentation that came with Readiris, or whichever OCR software you use,
for information on how to select the OCR language.
Troubleshooting

Errors
If the HP All-in-One has an error, the lights on the device might flash, or an error message
might appear on your computer screen.
This section contains the following topics:
•
•
•
•
•
•
•

Flashing lights
Device messages
File messages
General user messages
Paper messages
Power and connection messages
Print cartridge messages

Flashing lights
The lights on the HP All-in-One flash in special sequences to inform you about various
error conditions. Refer to the following table for information on solving your error condition
based on which lights are on or blinking on the HP All-in-One.
On light

Resume
light

Check
Print
Cartridge
light

Paper
Type
lights

Description

Solution

Off

Off

Off

Both off

The HP All-in-One is
turned off.

Press the On button
to turn the HP All-inOne on.

Blinking

Off

Off

1 On,

The HP All-in-One is
processing a job,
such as print, scan,
copy, or alignment.

Wait for the HP All-inOne to finish.

The HP All-in-One is
busy.

Wait for the HP All-inOne to finish.

Scan was pressed,
and there was no
response from the
computer.

Make sure the
computer is turned
on, the HP All-in-One
software is installed,
and the computer is

1 Off
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Blink faster
for 3
seconds
and then
On

Off

Blink for 20
seconds
and then
On

Off
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Off

1 On,
1 Off

Off

1 On,
1 Off

(continued)
On light

Resume
light

Check
Print
Cartridge
light

Paper
Type
lights

Description

Solution

On

Blinking

Off

1 On,
1 Off

On

Off

Blinking

1 On,
1 Off

The HP All-in-One is
out of paper.

Load paper and press
Start Copy Black or
Start Copy Color.

The HP All-in-One
has a paper jam.

Clear the paper jam,
and press Start Copy
Black or Start Copy
Color.

Paper-size setting
does not match the
paper size detected
in the input tray.

Change the paper in
the tray or the size
setting in the
software.

Print cartridge door
is open.

Raise the door to
close it.

The print cartridges
are missing or not
seated correctly.

Install or remove and
reinsert print
cartridges.

The tape was not
removed from the
print cartridge.

Remove print
cartridge, remove
tape, and reinsert
print cartridge.

The print cartridge is
not intended for use
in this HP All-inOne.

The print cartridge
might not be
supported for use in
the HP All-in-One.
See the Order
Supplies chapter in
the User Guide.

The print cartridge
might be defective.

1.

2.
3.

Remove the
black print
cartridge.
Close the print
cartridge door.
Check the On
light.
• If the On light
blinks,
replace the
tri-color print
cartridge.
• If the On light
remains
steadily lit,
replace the
black print
cartridge.
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connected to the
HP All-in-One with a
USB cable.
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(continued)
On light

Resume
light

Check
Print
Cartridge
light

Paper
Type
lights

Description

Solution

On

Blinking

Blinking

1 On,

The print carriage is
stalled.

Open the print
cartridge door, and
check that the
carriage is not
blocked.

The control panel
overlay is not
attached or is not
attached properly.

1.

1 Off
Troubleshooting

On

Blinking

Blinking

Both
blinking

2.

3.
Blinking

Blinking

Blinking

Both off

Scanner failure

Turn the HP Allin-One off.
Attach the control
panel overlay
using the
instructions in the
Setup Guide.
Turn the HP Allin-One back on.

Turn the HP All-inOne off, then on
again.
If the problem
persists, contact HP
customer support.

Blinking

Blinking

Blinking

Both
blinking

The HP All-in-One
has a fatal error.

1.
2.
3.

4.

Turn the HP Allin-One off.
Unplug the power
cord.
Wait a minute,
then plug the
power cord back
in.
Turn the HP Allin-One back on.

If the problem
persists, contact HP
Support.

Device messages
The following is a list of device-related error messages:
•
•
•
•

Firmware revision mismatch
Mechanism error
Memory is full
Scanner failure

Firmware revision mismatch
Cause: The revision number of the HP All-in-One firmware does not match the
revision number of the software.
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Solution: To find support and warranty information, go to the HP Web site at
www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

Mechanism error
Solution:

Troubleshooting

Cause: The HP All-in-One has a paper jam.
Clear the paper jam.

For more information, see:
Clear paper jams
Cause: The print carriage is blocked.
Solution: Turn the HP All-in-One off, remove any objects that are blocking the print
carriage (including any packing materials), and then turn the HP All-in-One on again.

Memory is full
Cause: The document you are copying has exceeded the memory of the HP All-inOne.
Solution:

Try making fewer copies at a time.

Scanner failure
Cause: The HP All-in-One is busy or an unknown cause has interrupted your scan.
Solution: Turn off the HP All-in-One and then turn it on again. Restart your
computer and then try to scan again.
If the problem persists, try plugging the power cord directly into a grounded power
outlet rather than a surge protector or power strip. If the problem continues, contact
HP Support. Go to www.hp.com/support. If prompted, choose your country/region,
and then click Contact HP for information on calling for technical support.
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File messages
The following is a list of file-related error messages:

Troubleshooting

•
•
•
•
•

Error reading or writing the file
File not found
File format not supported
Invalid file name
Supported file types for the HP All-in-One

Error reading or writing the file
Cause:

The HP All-in-One software could not open or save the file.

Solution:

Check to see if you have the right folder and file name.

File not found
Cause: There is not enough available memory on your computer to create a print
preview file.
Solution:

Close some applications and try the task again.

File format not supported
Cause: The HP All-in-One software did not recognize or support the file format of
the image you are trying to open or save. If the file extension indicates it is a supported
file type, the file might be corrupted.
Solution: Open the file in another application, and save it in a format that the HP Allin-One software recognizes.
For more information, see:
Supported file types for the HP All-in-One

Invalid file name
Cause:

The file name you entered is invalid.

Solution:

Make sure that you are not using any invalid symbols in the file name.

Supported file types for the HP All-in-One
When you save a scanned image, the HP All-in-One software recognizes the following
file formats: BMP, DCX, FPX, GIF, JPG, PCD, PCX, and TIF.

General user messages
The following is a list of messages related to common user errors:
•
•
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Disconnected
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•
•

No scan options
Out of disk space

Cannot crop
Solution: Close all applications that are not in use. This includes applications that
run in the background, such as screen savers and virus checkers. If you turn off your
virus checker, remember to turn it back on after you finish your scan.
If this problem occurs frequently, or if you encounter memory problems while using
other applications, you might need to add more memory to your computer. See the
user guide that came with your computer for more information.
Cause: For scanning, there must be at least 50 MB of space available on your
computer's hard disk.
Solution: Empty the Recycle Bin on your desktop. You might also need to remove
files from the hard disk; for example, delete temporary files.

Disconnected
Cause: Several situations can cause this error message to appear.
• Your computer is not turned on.
• Your computer is not connected to the HP All-in-One.
• The software that came with the HP All-in-One was not installed correctly.
• The software that came with the HP All-in-One is installed, but it is not running.
Solution: Make sure your computer is turned on and is connected to the HP All-inOne. Also make sure you installed the software that came with the HP All-in-One.
For more information, see:
Communication problems over a USB connection

No scan options
Cause: The software that came with the HP All-in-One is not running, or has never
been installed.
Solution: Make sure the software is installed and running. For more information,
see the Setup Guide that came with the HP All-in-One.

Out of disk space
Cause: There is not enough available memory on your computer to perform the
task.
Solution:

Close some applications and try the task again.
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Cause: The computer does not have enough memory.
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Paper messages
The following is a list of paper-related error messages:

Troubleshooting

•
•
•
•
•
•

Cannot load paper from input tray
Ink is drying
Out of paper
Paper jam, misfeed or blocked carriage
Paper mismatch
Wrong paper width

Cannot load paper from input tray
Cause:

There is not enough paper in the input tray.

Solution: If the HP All-in-One is out of paper or there are only a few sheets
remaining, load more paper in the input tray. If there is paper in the input tray, remove
the paper, tap the stack of paper against a flat surface, and reload the paper into the
input tray. To continue your print job, press the Resume button on the control panel
of the HP All-in-One.

Ink is drying
Cause: Transparencies and some other media require a drying time that is longer
than normal.
Solution: Leave the sheet in the output tray until the message disappears. If it is
necessary to remove the printed sheet before the message disappears, carefully hold
the printed sheet on the underside or the edges, and place it on a flat surface to dry.

Out of paper
Cause:

There is not enough paper in the input tray.

Solution: If the HP All-in-One is out of paper or there are only a few sheets
remaining, load more paper in the input tray. If there is paper in the input tray, remove
the paper, tap the stack of paper against a flat surface, and reload the paper into the
input tray. To continue your print job, press the Resume button on the control panel
of the HP All-in-One.
Cause:

The rear door is off the HP All-in-One.

Solution:

If you removed the rear door to clear a paper jam, replace it.

For more information, see:
Clear paper jams

Paper jam, misfeed or blocked carriage
Cause:
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The HP All-in-One has a paper jam.

Solution:

Clear the paper jam.

For more information, see:
Clear paper jams

Solution: Turn the HP All-in-One off, remove any objects that are blocking the print
carriage (including any packing materials), and then turn the HP All-in-One on again.

Paper mismatch
Cause: The print setting for the print job does not match the paper type or size
loaded in the HP All-in-One.
Solution:

Change the print setting or load the appropriate paper in the input tray.

For more information, see:
•
•

Set the paper type for printing
Choose papers for printing and copying

Wrong paper width
Cause: The print setting for the print job does not match the paper type or size
loaded in the HP All-in-One.
Solution:

Change the print setting or load the appropriate paper in the input tray.

For more information, see:
•
•

Set the paper type for printing
Choose papers for printing and copying

Power and connection messages
The following is a list of power- and connection-related error messages:
•
•

HP All-in-One not found
Communication test failed

Errors
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Cause: The print carriage is blocked.
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•
•

Improper shutdown
Two-way communication lost

HP All-in-One not found
Cause: This error applies only to USB-connected devices. The USB cable is not
plugged in properly.
Troubleshooting

Solution: If the HP All-in-One is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is securely connected to
the HP All-in-One and the computer, as shown below.

For more information, see:
Communication problems over a USB connection

Communication test failed
Cause:

The HP All-in-One is turned off.

Solution: Look at the On light located on the front of the HP All-in-One. If it is not
lit, the HP All-in-One is turned off. Make sure the power cord is firmly connected to
the HP All-in-One and plugged into a power outlet. Press the On button to turn on the
HP All-in-One.
Cause:
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The computer is not communicating with the HP All-in-One.
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Solution: If the HP All-in-One is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is connected to the HP Allin-One and the computer as shown below.

For more information, see:
Communication problems over a USB connection

Improper shutdown
Cause: The last time the HP All-in-One was used, it was not turned off properly. If
the HP All-in-One is turned off by turning off the switch on a power strip or by using
a wall switch, the device can be damaged.
Solution: Press the On button located on the control panel of the HP All-in-One to
turn the device on and off.

Two-way communication lost
Cause: The HP All-in-One is turned off.
Solution: Look at the On light located on the front of the HP All-in-One. If it is not
lit, the HP All-in-One is turned off. Make sure the power cord is firmly connected to
the HP All-in-One and plugged into a power outlet. Press the On button to turn on the
HP All-in-One.
Cause: The HP All-in-One is not connected to the computer.
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Solution: If the HP All-in-One is not properly connected to the computer,
communication errors can occur. Make sure the USB cable is securely connected to
the HP All-in-One and the computer, as shown below.

Troubleshooting

For more information, see:
Communication problems over a USB connection

Print cartridge messages
The following is a list of print cartridge error messages:
•
•
•
•
•

Low on ink
Need alignment or alignment failed
Print cartridge is missing, incorrectly installed, or not intended for your device
Printing in ink-backup mode
Print cartridge is faulty or not installed properly

Low on ink
Cause:

One or both print cartridges might be out of ink.

Solution: Check the estimated ink levels remaining in the print cartridges. If the
print cartridges are low or out of ink, you might need to replace the print cartridges.
NOTE: The HP All-in-One can only detect the ink levels for genuine HP ink. The
ink levels in print cartridges that are refilled or have been used in other devices,
might not register accurately.
If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.
NOTE: Do not remove the old print cartridge until a new one is available.
For more information on print cartridges, see Print cartridge troubleshooting.
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Need alignment or alignment failed
Cause: The incorrect type of paper is loaded in the input tray.

To find support and warranty information, go to the HP Web site at www.hp.com/
support. If prompted, choose your country/region, and then click Contact HP for
information on calling for technical support.
Cause: Protective tape is covering the print cartridges.
Solution: Check each print cartridge. The tape might have been removed from the
copper-colored contacts, but still might cover the ink nozzles. If the tape is still
covering the ink nozzles, carefully remove the tape from the print cartridges. Do not
touch the ink nozzles or the copper-colored contacts.

1

Copper-colored contacts

2

Plastic tape with pink pull tab (must be removed before installing)

3

Ink nozzles under tape

Remove and then reinsert the print cartridges. Verify that they are fully inserted and
locked in place.
Cause: The contacts on the print cartridge are not touching the contacts in the print
carriage.
Solution: Remove and then reinsert the print cartridges. Verify that they are fully
inserted and locked in place.
Cause: The print cartridge or sensor is defective.
Errors
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Solution: If you have colored paper loaded in the input tray when you align the print
cartridges, the alignment fails. Load unused plain white letter or A4 paper into the
input tray, and then try the alignment again. If the alignment fails again, you might
have a defective sensor or print cartridge.

Chapter 12

Solution: To find support and warranty information, go to the HP Web site at
www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.
Cause:

You installed new print cartridges that might need alignment.

Solution:

You must align the print cartridges to ensure excellent print quality.

Troubleshooting

If the alignment error persists and you cannot clear it , your print cartridge might be
defective. Contact HP for support.
To find support and warranty information, go to the HP Web site at www.hp.com/
support. If prompted, choose your country/region, and then click Contact HP for
information on calling for technical support.
For more information, see:
Align the print cartridges

Print cartridge is missing, incorrectly installed, or not intended for your device
Cause:

The print cartridge is missing.

Solution: One or both of the print cartridges is missing. Remove and reinsert the
print cartridges and verify that they are fully inserted and locked in place. If the
problem persists, clean the contacts of the print cartridges.
For more information on print cartridges, see Print cartridge troubleshooting.
Cause:

Protective tape is covering the print cartridges.

Solution: Check each print cartridge. The tape might have been removed from the
copper-colored contacts, but still might cover the ink nozzles. If the tape is still
covering the ink nozzles, carefully remove the tape from the print cartridges. Do not
touch the ink nozzles or the copper-colored contacts.
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1

Copper-colored contacts

2

Plastic tape with pink pull tab (must be removed before installing)

3

Ink nozzles under tape
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Solution: Remove and then reinsert the print cartridges. Verify that they are fully
inserted and locked in place.
If the problem persists, clean the copper-colored contacts of the print cartridges.
For more information on print cartridges, see Print cartridge troubleshooting.
Cause: The print cartridge is defective or not intended for use in this device.
Solution: To find support and warranty information, go to the HP Web site at
www.hp.com/support. If prompted, choose your country/region, and then click
Contact HP for information on calling for technical support.

Printing in ink-backup mode
Cause: When the HP All-in-One detects that only one print cartridge is installed,
ink-backup mode is initiated. This printing mode lets you print with a single print
cartridge, but it slows the device and affects the quality of printouts.
Solution: If you receive the ink-backup mode message and two print cartridges are
installed in the HP All-in-One, verify that the protective piece of plastic tape has been
removed from each print cartridge. When plastic tape covers the print cartridge
contacts, the device cannot detect that the print cartridge is installed.

Print cartridge is faulty or not installed properly
Cause: The printer cannot print if the print cartridges are faulty, or if they are not
installed properly.

Errors
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Cause: One or both of the print cartridges are not installed or are installed
incorrectly.

Chapter 12

Solution:

Troubleshooting

To resolve the problem
1. Open the print cartridge door.
2. Do one of the following:
• If an error message is displayed on screen, remove the print cartridge that is
named in the error message. Go to step 3.
• If an error message is not displayed, remove and reinstall each print cartridge
and close the print cartridge door.
If the Check Print Cartridge light is not flashing, the problem is solved.
If the Check Print Cartridge light is flashing, go to step 4.
3. Reinstall the print cartridge and close the print cartridge door. For more
information, see Replace the print cartridges.
If the Check Print Cartridge light is not flashing, the problem is solved.
If the Check Print Cartridge light is flashing, go to step 4.
4. Manually clean the print cartridge. For more information, see Clean the print
cartridge contacts.
5. Reinsert the print cartridge in the device and close the print cartridge door.
If the Check Print Cartridge light is still flashing, the print cartridge is faulty and
must be replaced.
NOTE: You can print with one print cartridge in ink-backup mode if you do
not have a replacement print cartridge available. For more information, see
Use ink-backup mode.
6. If the Check Print Cartridge light continues to flash after replacing the print
cartridge, visit HP Technical Support at www.hp.com/support.
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13 HP warranty and support
Hewlett-Packard provides Internet and phone support for the HP All-in-One.
This section contains the following topics:
Warranty
•
•

Support process

•
•

Before you call HP customer support
HP support by phone

•

Additional warranty options

•
•

HP Korea customer support
Prepare the HP All-in-One for shipment

•

Pack the HP All-in-One

For more information about the warranty, see the printed documentation that came with the HP Allin-One.

Support process
If you have a problem, follow these steps:
1. Check the documentation that came with the HP All-in-One.
2.

Visit the HP online support Web site at www.hp.com/support. HP online support is available to
all HP customers. It is the fastest source for up-to-date device information and expert assistance
and includes the following features:
•

3.

Fast access to qualified online support specialists

•

Software and driver updates for the HP All-in-One

•

Valuable HP All-in-One and troubleshooting information for common problems

•

Proactive device updates, support alerts, and HP newsgrams that are available when you
register the HP All-in-One

Call HP support. Support options and availability vary by device, country/region, and language.

Before you call HP customer support
Software programs from other companies might be included with the HP All-in-One. If you experience
problems with any of those programs, you will receive the best technical assistance by calling the
experts at that company.
If you need to contact HP support, do the following before you call:
1. Make sure that:
a.

The HP All-in-One is plugged in and turned on.

b. The specified print cartridges are installed correctly.
c.
2.

The recommended paper is properly loaded in the input tray.

Reset the HP All-in-One:
a.

Turn off the HP All-in-One by pressing the On button.

b. Unplug the power cord from the back of the HP All-in-One.
c.

Plug the power cord back into the HP All-in-One.

d. Turn on the HP All-in-One by pressing the On button.

HP warranty and support
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3.

To find support and warranty information, go to the HP Web site at www.hp.com/support. If
prompted, choose your country/region, and then click Contact HP for information on calling for
technical support.
Check the HP Web site for updated information or troubleshooting tips for the HP All-in-One.

4.

If you are still experiencing problems and need to speak with an HP support Representative, do
the following:
a. Have the specific name of the HP All-in-One, as it appears on the control panel, available.
b. Print a self-test report.
c. Make a color copy to have available as a sample printout.
d. Be prepared to describe your problem in detail.
e.

5.

Have your serial number ready.
You can view the serial number by looking at the sticker on the rear side of the HP All-inOne. The serial number is the 10-character code in the upper left corner of the sticker.

Call HP support. Be near the HP All-in-One when you call.

Related topics
•
Print a self-test report
HP warranty and support

•

Placing a call

HP support by phone
For a list of support phone numbers, see the printed documentation that came with the device.
This section contains the following topics:
•
Phone support period
•

Placing a call

•

After the phone support period

Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin America (including
Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to
www.hp.com/support. Standard phone company charges apply.

Placing a call
Call HP support while you are in front of the computer and the HP All-in-One. Be prepared to provide
the following information:
•

Model number (located on the label on the front of the HP All-in-One)

•

Serial number (located on the back or bottom of the HP All-in-One)

•

Messages that appear when the situation occurs

•

Answers to these questions:
•

Has this situation happened before?

•

Can you re-create it?

•

Did you add any new hardware or software to your computer at about the time that this
situation began?

•

Did anything else occur prior to this situation (such as a thunderstorm, HP All-in-One was
moved, etc.)?

After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may also be
available at the HP online support Web site: www.hp.com/support. Contact your HP dealer or call
the support phone number for your country/region to learn more about support options.
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Additional warranty options
Extended service plans are available for the HP All-in-One at additional costs. Go to www.hp.com/
support, select your country/region and language, then explore the services and warranty area for
information about the extended service plans.

Prepare the HP All-in-One for shipment
If after contacting HP Customer Support or returning to the point of purchase you are requested to
send the HP All-in-One in for service, make sure you remove and keep the following items before
returning your device:
•

The print cartridges

•

The power cord, USB cable, and any other cable connected to the HP All-in-One

•

Any paper loaded in the input tray

•

Any originals loaded in the HP All-in-One

To remove print cartridges before shipment
1. Turn on the HP All-in-One and wait until the print carriage is idle and silent. If the HP All-in-One
will not turn on, skip this step and go to step 2.
2.

Open the print cartridge door.

3.

Remove the print cartridges from their slots.
NOTE: If the HP All-in-One does not turn on, you can unplug the power cord and then
manually slide the print carriage to the center to remove the print cartridges.

4.

Place the print cartridges in an airtight plastic container so they will not dry out, and put them
aside. Do not send them with the HP All-in-One unless the HP customer support call agent
instructs you to.

5.

Close the print cartridge door and wait a few minutes for the print carriage to move back to its
home position (on the left side).
NOTE: Make sure the scanner is idle and has returned to its parked position before turning
off the HP All-in-One.

6.

Press the On button to turn off the HP All-in-One.

Pack the HP All-in-One
Complete the following steps once you have removed the print cartridges, turned off the HP All-inOne, and unplugged it.

Additional warranty options
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To pack the HP All-in-One
1. If available, pack the HP All-in-One for shipment by using the original packing materials or the
packaging materials that came with your exchange device.

HP warranty and support

If you do not have the original packaging materials, please use other adequate packaging
materials. Shipping damage caused by improper packaging and/or improper transportation is
not covered under the warranty.
2.

Place the return shipping label on the outside of the box.

3.

Include the following items in the box:
•
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•

A complete description of symptoms for service personnel (samples of print quality problems
are helpful).
A copy of the sales slip or other proof of purchase to establish the warranty coverage period.

•

Your name, address, and a phone number where you can be reached during the day.
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14 Technical information
The technical specifications and international regulatory information for the HP All-in-One are
provided in this section.
For additional specifications, see the printed Basics Guide.
This section contains the following topics:
•

Specifications

•

Environmental product stewardship program

•

Regulatory notices

Specifications
Technical specifications for the HP All-in-One are provided in this section. For additional
specifications, see the printed Basics Guide.
System requirements
Software and system requirements are located in the Readme file.
For information about future operating system releases and support, visit the HP online support Web
site at www.hp.com/support.

Type

Paper weight

Paper tray*

Output tray*

Plain paper

20 to 24 lb. (75 to 90
gsm)

100 (20 lb. paper)

50 (20 lb. paper)

Legal paper

20 to 24 lb. (75 to 90
gsm)

100 (20 lb. paper

50 (20 lb. paper)

Cards

110 lb. index max (200
gsm)

20

10

Envelopes

20 to 24 lb. (75 to 90
gsm)

10

10

Transparency film

N/A

20

15 or fewer

Labels

N/A

20

10

4 x 6 inch (10 x 15 cm) Photo
paper

145 lb.

20

15

8.5 x 11 inch (216 x 279 mm)
Photo paper

N/A

20

10

*
*

Technical information

Paper specifications

(236 gsm)

Maximum capacity.
Output tray capacity is affected by the type of paper and the amount of ink you are using.
HP recommends emptying the output tray frequently.
NOTE: For a complete list of supported media sizes, see the printer software.

Copy specifications
•
Digital image processing
•

Up to 9 copies from original (depends on model)

Technical information
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•

Copy speeds vary according to the complexity of the document and model

•

Maximum copy enlargement ranging from 200-400% (depends on model)

•

Maximum copy reduction ranging from 25-50% (depends on model)

Scan specifications
•
Image editor included
•

Integrated OCR software automatically converts scanned text to editable text (if installed)

•

Twain-compliant software interface

•

Resolution: up to 1200 x 2400 ppi optical (depends on model); 19200 ppi enhanced (software)
For more information about ppi resolution, see the scanner software.

•

Color: 48-bit color, 8-bit grayscale (256 levels of gray)

•

Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)

Print resolution
To find out about the printer resolution, see the printer software. For more information, see View the
print resolution.
Print cartridge yield
Visit www.hp.com/pageyield for more information on estimated cartridge yields.
Acoustic information
If you have Internet access, you can get acoustic information from the HP Web site. Go to:
www.hp.com/support.

Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sound manner.
Design for recycling has been incorporated into this product. The number of materials has been kept
to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been
designed to separate easily. Fasteners and other connections are easy to locate, access, and
remove using common tools. High priority parts have been designed to access quickly for efficient
disassembly and repair.

Technical information

For more information, visit HP’s Commitment to the Environment Web site at:
www.hp.com/hpinfo/globalcitizenship/environment/index.html
This section contains the following topics:
•
•
•
•
•
•
•

Paper use
Plastics
Material safety data sheets
Recycling program
HP inkjet supplies recycling program
Energy consumption
Disposal of waste equipment by users in private households in the European Union

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability
to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at:
www.hp.com/go/msds
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Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions,
and partners with some of the largest electronic recycling centers throughout the world. HP
conserves resources by reselling some of its most popular products. For more information regarding
recycling of HP products, please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is
available in many countries/regions, and lets you recycle used print cartridges and ink cartridges
free of charge. For more information, go to the following Web site:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Energy consumption

Technical information

This product is designed to reduce power consumption and save natural resources without
compromising product performance. It has been designed to reduce total energy consumption both
during operation and when the device is not active. Specific information on power consumption may
be found in the printed documentation that came with the HP All-in-One.

Environmental product stewardship program
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English
Français
Deutsch
Italiano
Español

Eliminación de residuos de aparatos eléctricos y electrónicos por parte de usuarios domésticos en la Unión Europea
Este símbolo en el producto o en el embalaje indica que no se puede desechar el producto junto con los residuos domésticos. Por el contrario, si debe eliminar este tipo de residuo, es
responsabilidad del usuario entregarlo en un punto de recogida designado de reciclado de aparatos electrónicos y eléctricos. El reciclaje y la recogida por separado de estos residuos
en el momento de la eliminación ayudará a preservar recursos naturales y a garantizar que el reciclaje proteja la salud y el medio ambiente. Si desea información adicional sobre los
lugares donde puede dejar estos residuos para su reciclado, póngase en contacto con las autoridades locales de su ciudad, con el servicio de gestión de residuos domésticos o con la
tienda donde adquirió el producto.

Česky

Likvidace vysloužilého zařízení uživateli v domácnosti v zemích EU
Tato značka na produktu nebo na jeho obalu označuje, že tento produkt nesmí být likvidován prostým vyhozením do běžného domovního odpadu. Odpovídáte za to, že vysloužilé
zařízení bude předáno k likvidaci do stanovených sběrných míst určených k recyklaci vysloužilých elektrických a elektronických zařízení. Likvidace vysloužilého zařízení samostatným
sběrem a recyklací napomáhá zachování přírodních zdrojů a zajišťuje, že recyklace proběhne způsobem chránícím lidské zdraví a životní prostředí. Další informace o tom, kam můžete
vysloužilé zařízení předat k recyklaci, můžete získat od úřadů místní samosprávy, od společnosti provádějící svoz a likvidaci domovního odpadu nebo v obchodě, kde jste produkt
zakoupili.

Dansk

Bortskaffelse af affaldsudstyr for brugere i private husholdninger i EU
Dette symbol på produktet eller på dets emballage indikerer, at produktet ikke må bortskaffes sammen med andet husholdningsaffald. I stedet er det dit ansvar at bortskaffe affaldsudstyr
ved at aflevere det på dertil beregnede indsamlingssteder med henblik på genbrug af elektrisk og elektronisk affaldsudstyr. Den separate indsamling og genbrug af dit affaldsudstyr på
tidspunktet for bortskaffelse er med til at bevare naturlige ressourcer og sikre, at genbrug finder sted på en måde, der beskytter menneskers helbred samt miljøet. Hvis du vil vide mere
om, hvor du kan aflevere dit affaldsudstyr til genbrug, kan du kontakte kommunen, det lokale renovationsvæsen eller den forretning, hvor du købte produktet.

Nederlands

Afvoer van afgedankte apparatuur door gebruikers in particuliere huishoudens in de Europese Unie
Dit symbool op het product of de verpakking geeft aan dat dit product niet mag worden afgevoerd met het huishoudelijk afval. Het is uw verantwoordelijkheid uw afgedankte apparatuur
af te leveren op een aangewezen inzamelpunt voor de verwerking van afgedankte elektrische en elektronische apparatuur. De gescheiden inzameling en verwerking van uw afgedankte
apparatuur draagt bij tot het sparen van natuurlijke bronnen en tot het hergebruik van materiaal op een wijze die de volksgezondheid en het milieu beschermt. Voor meer informatie over
waar u uw afgedankte apparatuur kunt inleveren voor recycling kunt u contact opnemen met het gemeentehuis in uw woonplaats, de reinigingsdienst of de winkel waar u het product
hebt aangeschaft.

Eesti

Eramajapidamistes kasutuselt kõrvaldatavate seadmete käitlemine Euroopa Liidus
Kui tootel või toote pakendil on see sümbol, ei tohi seda toodet visata olmejäätmete hulka. Teie kohus on viia tarbetuks muutunud seade selleks ettenähtud elektri- ja elektroonikaseadmete
utiliseerimiskohta. Utiliseeritavate seadmete eraldi kogumine ja käitlemine aitab säästa loodusvarasid ning tagada, et käitlemine toimub inimeste tervisele ja keskkonnale ohutult.
Lisateavet selle kohta, kuhu saate utiliseeritava seadme käitlemiseks viia, saate küsida kohalikust omavalitsusest, olmejäätmete utiliseerimispunktist või kauplusest, kust te seadme
ostsite.

Suomi

Hävitettävien laitteiden käsittely kotitalouksissa Euroopan unionin alueella
Tämä tuotteessa tai sen pakkauksessa oleva merkintä osoittaa, että tuotetta ei saa hävittää talousjätteiden mukana. Käyttäjän velvollisuus on huolehtia siitä, että hävitettävä laite
toimitetaan sähkö- ja elektroniikkalaiteromun keräyspisteeseen. Hävitettävien laitteiden erillinen keräys ja kierrätys säästää luonnonvaroja. Näin toimimalla varmistetaan myös,
että kierrätys tapahtuu tavalla, joka suojelee ihmisten terveyttä ja ympäristöä. Saat tarvittaessa lisätietoja jätteiden kierrätyspaikoista paikallisilta viranomaisilta, jäteyhtiöiltä tai tuotteen
jälleenmyyjältä.

Ελληνικά

Απόρριψη άχρηστων συσκευών στην Ευρωπαϊκή Ένωση
Το παρόν σύμβολο στον εξοπλισμό ή στη συσκευασία του υποδεικνύει ότι το προϊόν αυτό δεν πρέπει να πεταχτεί μαζί με άλλα οικιακά απορρίμματα. Αντίθετα, ευθύνη σας είναι να
απορρίψετε τις άχρηστες συσκευές σε μια καθορισμένη μονάδα συλλογής απορριμμάτων για την ανακύκλωση άχρηστου ηλεκτρικού και ηλεκτρονικού εξοπλισμού. Η χωριστή συλλογή και
ανακύκλωση των άχρηστων συσκευών θα συμβάλει στη διατήρηση των φυσικών πόρων και στη διασφάλιση ότι θα ανακυκλωθούν με τέτοιον τρόπο, ώστε να προστατεύεται η υγεία των
ανθρώπων και το περιβάλλον. Για περισσότερες πληροφορίες σχετικά με το πού μπορείτε να απορρίψετε τις άχρηστες συσκευές για ανακύκλωση, επικοινωνήστε με τις κατά τόπους αρμόδιες
αρχές ή με το κατάστημα από το οποίο αγοράσατε το προϊόν.

Magyar

A hulladékanyagok kezelése a magánháztartásokban az Európai Unióban
Ez a szimbólum, amely a terméken vagy annak csomagolásán van feltüntetve, azt jelzi, hogy a termék nem kezelhető együtt az egyéb háztartási hulladékkal. Az Ön feladata,
hogy a készülék hulladékanyagait eljuttassa olyan kijelölt gyűjtőhelyre, amely az elektromos hulladékanyagok és az elektronikus berendezések újrahasznosításával foglalkozik.
A hulladékanyagok elkülönített gyűjtése és újrahasznosítása hozzájárul a természeti erőforrások megőrzéséhez, egyúttal azt is biztosítja, hogy a hulladék újrahasznosítása az
egészségre és a környezetre nem ártalmas módon történik. Ha tájékoztatást szeretne kapni azokról a helyekről, ahol leadhatja újrahasznosításra a hulladékanyagokat, forduljon
a helyi önkormányzathoz, a háztartási hulladék begyűjtésével foglalkozó vállalathoz vagy a termék forgalmazójához.

Latviski

Lietotāju atbrīvošanās no nederīgām ierīcēm Eiropas Savienības privātajās mājsaimniecībās
Šis simbols uz ierīces vai tās iepakojuma norāda, ka šo ierīci nedrīkst izmest kopā ar pārējiem mājsaimniecības atkritumiem. Jūs esat atbildīgs par atbrīvošanos no nederīgās ierīces,
to nododot norādītajā savākšanas vietā, lai tiktu veikta nederīgā elektriskā un elektroniskā aprīkojuma otrreizējā pārstrāde. Speciāla nederīgās ierīces savākšana un otrreizējā pārstrāde
palīdz taupīt dabas resursus un nodrošina tādu otrreizējo pārstrādi, kas sargā cilvēku veselību un apkārtējo vidi. Lai iegūtu papildu informāciju par to, kur otrreizējai pārstrādei var
nogādāt nederīgo ierīci, lūdzu, sazinieties ar vietējo pašvaldību, mājsaimniecības atkritumu savākšanas dienestu vai veikalu, kurā iegādājāties šo ierīci.

Lietuviškai

Europos Sąjungos vartotojų ir privačių namų ūkių atliekamos įrangos išmetimas
Šis simbolis ant produkto arba jo pakuotės nurodo, kad produktas negali būti išmestas kartu su kitomis namų ūkio atliekomis. Jūs privalote išmesti savo atliekamą įrangą atiduodami ją
į atliekamos elektronikos ir elektros įrangos perdirbimo punktus. Jei atliekama įranga bus atskirai surenkama ir perdirbama, bus išsaugomi natūralūs ištekliai ir užtikrinama, kad įranga
yra perdirbta žmogaus sveikatą ir gamtą tausojančiu būdu. Dėl informacijos apie tai, kur galite išmesti atliekamą perdirbti skirtą įrangą kreipkitės į atitinkamą vietos tarnybą, namų ūkio
atliekų išvežimo tarnybą arba į parduotuvę, kurioje pirkote produktą.
Utylizacja zużytego sprzętu przez użytkowników domowych w Unii Europejskiej
Symbol ten umieszczony na produkcie lub opakowaniu oznacza, że tego produktu nie należy wyrzucać razem z innymi odpadami domowymi. Użytkownik jest odpowiedzialny za
dostarczenie zużytego sprzętu do wyznaczonego punktu gromadzenia zużytych urządzeń elektrycznych i elektronicznych. Gromadzenie osobno i recykling tego typu odpadów
przyczynia się do ochrony zasobów naturalnych i jest bezpieczny dla zdrowia i środowiska naturalnego. Dalsze informacje na temat sposobu utylizacji zużytych urządzeń można
uzyskać u odpowiednich władz lokalnych, w przedsiębiorstwie zajmującym się usuwaniem odpadów lub w miejscu zakupu produktu.

Português

Smaltimento di apparecchiature da rottamare da parte di privati nell'Unione Europea
Questo simbolo che appare sul prodotto o sulla confezione indica che il prodotto non deve essere smaltito assieme agli altri rifiuti domestici. Gli utenti devono provvedere allo
smaltimento delle apparecchiature da rottamare portandole al luogo di raccolta indicato per il riciclaggio delle apparecchiature elettriche ed elettroniche. La raccolta e il riciclaggio
separati delle apparecchiature da rottamare in fase di smaltimento favoriscono la conservazione delle risorse naturali e garantiscono che tali apparecchiature vengano rottamate
nel rispetto dell'ambiente e della tutela della salute. Per ulteriori informazioni sui punti di raccolta delle apparecchiature da rottamare, contattare il proprio comune di residenza,
il servizio di smaltimento dei rifiuti locale o il negozio presso il quale è stato acquistato il prodotto.

Descarte de equipamentos por usuários em residências da União Européia
Este símbolo no produto ou na embalagem indica que o produto não pode ser descartado junto com o lixo doméstico. No entanto, é sua responsabilidade levar os equipamentos
a serem descartados a um ponto de coleta designado para a reciclagem de equipamentos eletro-eletrônicos. A coleta separada e a reciclagem dos equipamentos no momento do
descarte ajudam na conservação dos recursos naturais e garantem que os equipamentos serão reciclados de forma a proteger a saúde das pessoas e o meio ambiente. Para obter mais
informações sobre onde descartar equipamentos para reciclagem, entre em contato com o escritório local de sua cidade, o serviço de limpeza pública de seu bairro ou a loja em que
adquiriu o produto.

Slovenčina

Entsorgung von Elektrogeräten durch Benutzer in privaten Haushalten in der EU
Dieses Symbol auf dem Produkt oder dessen Verpackung gibt an, dass das Produkt nicht zusammen mit dem Restmüll entsorgt werden darf. Es obliegt daher Ihrer Verantwortung, das
Gerät an einer entsprechenden Stelle für die Entsorgung oder Wiederverwertung von Elektrogeräten aller Art abzugeben (z.B. ein Wertstoffhof). Die separate Sammlung und das
Recyceln Ihrer alten Elektrogeräte zum Zeitpunkt ihrer Entsorgung trägt zum Schutz der Umwelt bei und gewährleistet, dass sie auf eine Art und Weise recycelt werden, die keine
Gefährdung für die Gesundheit des Menschen und der Umwelt darstellt. Weitere Informationen darüber, wo Sie alte Elektrogeräte zum Recyceln abgeben können, erhalten Sie bei
den örtlichen Behörden, Wertstoffhöfen oder dort, wo Sie das Gerät erworben haben.

Postup používateľov v krajinách Európskej únie pri vyhadzovaní zariadenia v domácom používaní do odpadu
Tento symbol na produkte alebo na jeho obale znamená, že nesmie by vyhodený s iným komunálnym odpadom. Namiesto toho máte povinnos odovzda toto zariadenie na zbernom
mieste, kde sa zabezpečuje recyklácia elektrických a elektronických zariadení. Separovaný zber a recyklácia zariadenia určeného na odpad pomôže chráni prírodné zdroje a
zabezpečí taký spôsob recyklácie, ktorý bude chráni ľudské zdravie a životné prostredie. Ďalšie informácie o separovanom zbere a recyklácii získate na miestnom obecnom úrade,
vo firme zabezpečujúcej zber vášho komunálneho odpadu alebo v predajni, kde ste produkt kúpili.

Slovenščina

Évacuation des équipements usagés par les utilisateurs dans les foyers privés au sein de l'Union européenne
La présence de ce symbole sur le produit ou sur son emballage indique que vous ne pouvez pas vous débarrasser de ce produit de la même façon que vos déchets courants.
Au contraire, vous êtes responsable de l'évacuation de vos équipements usagés et, à cet effet, vous êtes tenu de les remettre à un point de collecte agréé pour le recyclage des
équipements électriques et électroniques usagés. Le tri, l'évacuation et le recyclage séparés de vos équipements usagés permettent de préserver les ressources naturelles et de s'assurer
que ces équipements sont recyclés dans le respect de la santé humaine et de l'environnement. Pour plus d'informations sur les lieux de collecte des équipements usagés, veuillez contacter
votre mairie, votre service de traitement des déchets ménagers ou le magasin où vous avez acheté le produit.

Ravnanje z odpadno opremo v gospodinjstvih znotraj Evropske unije
Ta znak na izdelku ali embalaži izdelka pomeni, da izdelka ne smete odlagati skupaj z drugimi gospodinjskimi odpadki. Odpadno opremo ste dolžni oddati na določenem zbirnem
mestu za recikliranje odpadne električne in elektronske opreme. Z ločenim zbiranjem in recikliranjem odpadne opreme ob odlaganju boste pomagali ohraniti naravne vire in zagotovili,
da bo odpadna oprema reciklirana tako, da se varuje zdravje ljudi in okolje. Več informacij o mestih, kjer lahko oddate odpadno opremo za recikliranje, lahko dobite na občini,
v komunalnem podjetju ali trgovini, kjer ste izdelek kupili.

Svenska

Technical information

Disposal of Waste Equipment by Users in Private Households in the European Union
This symbol on the product or on its packaging indicates that this product must not be disposed of with your other household waste. Instead, it is your responsibility to dispose of your waste
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment
at the time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where
you can drop off your waste equipment for recycling, please contact your local city office, your household waste disposal service or the shop where you purchased the product.

Polski

Disposal of waste equipment by users in private households in the European Union

Kassering av förbrukningsmaterial, för hem- och privatanvändare i EU
Produkter eller produktförpackningar med den här symbolen får inte kasseras med vanligt hushållsavfall. I stället har du ansvar för att produkten lämnas till en behörig återvinningsstation
för hantering av el- och elektronikprodukter. Genom att lämna kasserade produkter till återvinning hjälper du till att bevara våra gemensamma naturresurser. Dessutom skyddas både
människor och miljön när produkter återvinns på rätt sätt. Kommunala myndigheter, sophanteringsföretag eller butiken där varan köptes kan ge mer information om var du lämnar
kasserade produkter för återvinning.

Regulatory notices
The HP All-in-One meets product requirements from regulatory agencies in your country/region.
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This section contains the following topics:
•
•
•
•
•
•
•

FCC statement
Notice to users in Korea
VCCI (Class B) compliance statement for users in Japan
Notice to users in Japan about the power cord
Noise emission statement for Germany
LED indicator statement
Toxic and hazardous substance table

FCC statement

FCC statement
The United States Federal Communications Commission (in 47 CFR 15.105) has specified
that the following notice be brought to the attention of users of this product.
This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation.
If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:
•
•
•
•

Reorient the receiving antenna.
Increase the separation between the equipment and the receiver.
Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

Technical information

For further information, contact:
Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501
Modifications (part 15.21)
The FCC requires the user to be notified that any changes or modifications made to this
device that are not expressly approved by HP may void the user's authority to operate the
equipment.
This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired
operation.

Notice to users in Korea

Regulatory notices
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VCCI (Class B) compliance statement for users in Japan

Notice to users in Japan about the power cord

Noise emission statement for Germany

Geräuschemission
LpA < 70 dB am Arbeitsplatz im Normalbetrieb nach DIN 45635 T. 19

LED indicator statement

LED indicator statement
The display LEDs meet the requirements of EN 60825-1.

Technical information

Toxic and hazardous substance table
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Index
10 x 15 cm photo paper
load 24
specifications 133
2 pages on 1, print 42
4 pages on 1, print 42
4 x 6 inch (10 x 15 cm)
borderless photos
print 36
4 x 6 inch photo paper, load 24

A
A4 paper, load 23
addresses, print 44
after the support period 130
align print cartridges 69
alignment
failed 125
print cartridges 125

B
blank
copy 110
scan 112
booklet printing 40
border 109
borderless copies 53
borderless photos
copy has borders 110
print 36
brightness, change in print 33
buttons, control panel 8

C
cancel
copy 53
print job 46
scan 57
cancel button 9
cartridges. See print cartridges
choose paper 19
clean
exterior 59
glass 59
lid backing 60
print cartridge contacts 71

print cartridge ink nozzle
area 72
print cartridges 71
color tone, change in print 33
communication problems
test failed 122
two-way communication
lost 123
connection problems
device not found 122
HP All-in-One does not turn
on 80
connection types supported
printer sharing 17
control panel
buttons 8,
copy
black-and-white
documents 52
blank 110
borderless has borders 110
borderless photo 53
cancel 53
make a copy 49
missing information 109
number of copies 51
paper types,
recommended 49
specifications 133
speed 50
troubleshooting 108
crop
fails 119
customer support
contact 129
warranty 129, 131

D
default printer, set as 30
device
no response 100
not found 122
disconnected error 119

documents
edit scanned 56
scan 55
double-sided prints 39, 40

E
edit
scan preview 56
edit scanned images 56
enlargement 109
envelopes
load 26
specifications 133
environment
Environmental product
stewardship program 134
error messages
out of paper 120
reading or writing file 118

F
fax
paper width incorrect 121
poor quality printouts 96, 97
fax problems
poor print quality 97
smeared ink 96
file
invalid name 118
supported formats 118
unsupported formats 118
firmware revision mismatch 116

G
glass
clean 59
greeting cards, load 27

H
HP JetDirect 17
HP Solution Center, missing
icons 85

Index

Symbols/Numerics
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I

M

images
edit scanned 56
scan 55
improper shutdown 123
ink
drying time 120
low 106, 124
sprays inside HP All-inOne 108
ink cartridges. See print
cartridges
ink levels, check 62
ink, removing ink from skin and
clothing 74
ink-backup mode 67
install software, troubleshoot 79
invalid file name 118
iron-on transfers 43

maintenance
align print cartridges 69
check ink levels 62
clean exterior 59
clean glass 59
clean lid backing 60
clean print cartridges 71
print cartridges 61
replace print cartridges 63
self-test report 60
make a copy 49
margins
incorrect 104, 109
text or graphic cut off 106
media. See paper
missing
information from copy 109
text from scan 113

J

N

jams, paper 28

no scan options error 119
number of copies
copy 51

L
labels
load 27
specifications 133
landscape orientation 32
legal paper
load 23
specifications 133
letter paper
load 23
specifications 133
lid backing, clean 60
load
10 x 15 cm photo paper 24
4 x 6 inch photo paper 24
A4 paper 23
envelopes 26
full-size paper 23
greeting cards 27
index cards 25
iron-on transfers 27
labels 27
legal paper 23
letter paper 23
original 19
transparencies 27

Index
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O
on button 8
order
paper 75
print cartridges 75
Setup Guide 76
software 76
User Guide 76
out of paper 120
overheads, print 43

P
page order 42
paper
choose 19
feed fails 99
incompatible types 22
jam 117, 120
jams 28, 79
load 22
misfeed 120
order 75
out of 120
recommended copy
types 49
recommended sizes for
printing 30

recommended types 20, 21
size incorrect 121
specifications 133
tips 78
type incorrect 121
width incorrect 121
paper type 31
phone numbers, customer
support 129
phone support 130
phone support period
period for support 130
photo paper
load 24
specifications 133
photos
edit scanned 56
ink sprays 108
photo print cartridge 67
print borderless 36
print on photo paper 37
Photosmart Software 9
poor fax printout quality 96, 97
portrait orientation 32
posters 45
preview image, edit 56
preview print job 33
print
2 or 4 pages on 1 42
addresses 44
blank printout 106
booklet 40
borderless fails 100
borderless photos 36
both sides of page 39
cancel job 46
cd/dvd labels 38
correct order 42
distorted printout 97
envelopes 44
envelopes print
incorrectly 100
from computer 29
from software application 29
iron-on transfers 43
labels 44
margins incorrect 104, 106
meaningless characters 102
multiple pages on one
sheet 42
nothing happens 103
on photo paper 37
posters 45

Index
printing
with one print cartridge 67
Printing Shortcuts tab 34
problems
copy 108
error messages 114
print 99
scan 111

Q
quality
print 32

R
Readme file 79
recycle
ink cartridges 135
regulatory notices 136
reinstall software 86
removing ink from skin and
clothing 74
replace print cartridges 63
reports
self-test 60
resolution
print 32
resume
print job 46

S
saturation, change in print 33
scan
blank 112
cancel 57
crop incorrect 112
documents 55
edit image 56
fails 111, 112, 117
features 55
halts 111
no scan options error 119
page layout incorrect 112
photos 55
preview image, edit 56
scan specifications 134
stop 57
text appears as dotted
lines 113
text format incorrect 113
text incorrect 113
troubleshooting 111
scan button 10

scan glass
clean 59
self-test report 60
set
print options 30, 34
ship your device 131
smeared ink, fax 96
software application, print
from 29
software installation
reinstall 86
troubleshoot 83
uninstall 86
speed
copy 50
print 32
start copy
black 9
color 9
status lights
overview 10
stop
copy 53
print job 46
scan 57
support process 129
system requirements 133

T
T-shirt transfers. See iron-on
transfers
technical information
copy specifications 133
paper specifications 133
scan specifications 134
system requirements 133
telephone numbers, customer
support 129
text
cut off 106
dotted lines on scan 113
incorrect format on
scan 113
incorrect or missing on
scan 113
jagged 97
meaningless characters 102
not filled in 97
smooth fonts 97
transparencies
load 27
specifications 133
Index

preview 33
print options 30, 34
quality, troubleshoot 96, 97,
98
resume job 46
reverse images 43
reversed page order 104
self-test report 60
special print jobs 36
transparencies 43
troubleshooting 99
vertical streaks 98
Web pages 45
print cartridge protector 68
print cartridges
align 69, 125
check ink levels 62
clean 71
clean contacts 71
clean ink nozzle area 72
error message 126
faulty 127
handle 62
incorrect 126
low ink 106
low on ink 124
not installed properly 127
order 75
part names 62
photo print cartridge 67
problem message 127
replace 63
store 68
tips 94
print quality 32
print settings
brightness 33
color tone 33
layout 32
orientation 32
paper size 30
paper type 31
print quality 95
quality 32
reduce/enlarge 33
resizing options 33
resolution 32
saturation 33
speed 32
printer sharing
Mac 17
Windows 17
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troubleshoot
fax problems 96, 97
hardware installation 79
jams, paper 28
Readme file 79
software installation 83
USB cable 81
troubleshooting
communication problems 77
copy 108
error messages 114
print 99
scan 111
two-sided prints 39, 40

U
uninstall software 86
USB cable
communication lost 123
USB cable installation 81

W
warranty 129, 131
Web pages, print 45
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